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Welcome

Oliver Hill
This issue, Oliver has been exploring a 

technological highway that Apple hasn’t sped 

along yet – roads – and delivers a full report into  

the world’s first iCar. Read about it on page 8. 

Shaun McGill
This month, tech expert Shaun provides hints and 

tips on how to become a YouTube sensation, 

starting on page 46. From mastering the service 

to building a brand, there is plenty to discover.

George Cairns
George specialises in creative visual apps and, 

as well as providing tutorials for Final Cut Pro X 

and Photos, also demonstrates how to create a 

cool teleportation effect in iMovie on page 26.

Meet the experts

“With over one billion users, most people 

know YouTube, but how well?”

 iCreate 173

In April Apple updated its iWork office suite of apps, 

comprising of Pages, Numbers and Keynote, and made 

them totally free to download on macOS and iOS. 

Previously, these apps were only available free to 

customers who purchased a new Mac or iOS device, 

but now Apple owners new and old can download and 

use them. If you aren’t yet familiar with the apps, they 

are Apple’s answer to Microsoft’s Word, Excel and 

PowerPoint office apps, but much more intuitive and 

easier to use and backed up by iCloud, so all of your 

docs are accessible from anywhere. In our iWork For 

Free feature on page 14 we provide plenty of hints and 

tips to help you become an instant expert in these apps.

Elsewhere, we decided to turn the spotlight on 

YouTube. With over one billion users worldwide, most 

people know of the app and how to use the service, but 

how well? We decided it was the right time to showcase 

ways to make the service work better for you as a 

viewer and provide some tips and advice on how to 

become the next YouTube sensation. Enjoy the issue.

Ryan Butt Editor
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#Trending

Apple’s plans to 

release its own 

self-driving car 

have been in 

development for 

several years now but, while 

the ideas might be lowing, the 
technology hasn’t quite been 

there to match it. However, big 

strides have been made in both 

the automotive and technology 

industries of late, and Apple’s 

self-driving dream may soon 

become reality. Codenamed 

‘Project Titan’, the exact design 

of the car is still relatively 

unknown but if initial reports are 

to be believed, it’s very much 

going to be a futuristic looking 

piece of kit. Now of course, it 

wouldn’t be Apple if it didn’t 

look the part, but it’s vastly more 

important that Apple manages 

to envelop the wider market 

and look past just its core user 

base. To aid with the design, 

it’s been noted that Apple has 

been working with top design 

teams from some of the world’s 

leading car manufacturers. Apple 

has been reported to be buying 

McLaren with their designers 

apparently helping to inesse the 
iner parts of the design.

Electric avenue

When it comes to technology, it’s 

no secret that Apple’s self-driving 

car is going to be fully electric, 

and in many ways, mimic what 

we’ve seen previously from 

Tesla. “The similarities between 

Tesla’s leet of cars, compared 

Apple’s ambitious electric car could soon be on the market

Apple’s self-
driving dream

to what Apple is proposing, are 

pretty close together. Massive 

improvements have been made 

in the electric car ield, with 
streamlined tech helping to 

keep vehicles going for longer,” 

explains freelance automotive 

writer, Tristian Klin. “However, 

it’s unknown what sort of 

coniguration Apple will choose 
to implement into its car, as there 

are several ways to tackle it.” 

Akin to what it has been doing 

with the design, Apple has been 

hiring leading car experts to help 

them with its electric efforts. 

Former staffers from Tesla are 

onboard, and it’s believed that 

Apple has been developing a 

completely new take on the 

electric car formula.

Race to the finish

Developing a self-driving car is 

the hot topic now, and there are 

plenty of other companies in the 

This is just one 
of the concepts 
being touted for 

the design of the 
Apple Car.



mix to be irst to get on the road. 
Google’s efforts have been well 

documented and are relatively 

close to completion, while the 

likes of Tesla, Nvidia and Waymo 

are also busy at work. While 

many may see Apple’s efforts 

rather mute at this point, it’s 

important to note that this isn’t 

its irst foray in this ield. Apple 
CarPlay has become a staple 

piece of software for a constantly 

growing number of vehicles. 

The software allows 

users to automate 

many aspects of their 

driving experience, 

and provides that link 

between iPhone and 

vehicle that certain 

users crave. Already, 

the likes of Honda, 

Hyundai and Subaru 

all have CarPlay-enabled vehicles 

on the market and thanks to 

Apple’s meticulous tracking of 

usage, implementing it into their 

own car should be relatively 

easy. “CarPlay can and will play 

a big role in Apple’s car project, 

there’s no doubt about it. What 

will be most intriguing, however, 

is how they look to maximise the 

automation part of the software 

into the vehicle. There’s potential 

here to control your car with  

your phone, but of course, 

regulations of the road will dictate 

how far they can take it:” says 

Tristian Klin.
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Top CarPlay apps
Apple’s CarPlay has proven to be  
a big hit thanks to these top apps

Audible
An audiobook is a great 

way to pass the time on 

your daily commute, and no app 

has a better selection of titles than 

Audible. Simply download your 

favourite book before you leave and 

have CarPlay read it to you. 

Castro
Castro looks to offer up 

hundreds of podcasts, 

which cover a wide range of 

categories and topics. The podcasts 

on offer can be downloaded while 

you are in the car, and they will play 

back instantly. 

Spotify
As far as music streaming 

services go, Spotify 

has to be up there with the best 

with them. Through its CarPlay 

integration, Spotify users are  

able to create and automate their 

favourite playlists. 

Pandora
One of the reasons 

Pandora is on this list, is 

due to the simplicity of this handy 

app. Open it up, pick a radio station 

and let the app play. Make sure to 

bookmark your favourite stations 

as well.

Maps
Of course, we couldn’t 

miss Maps off a list of 

handy apps for in-car use. It’s the 

perfect alternative to having a  

sat nav in your car and, thanks to its 

voice direction system, you’ll never 

get lost again. 

Despite the excitement of what 

Apple’s car may bring, there 

are of course certain limitations 

and hurdles that need to be 

addressed. At the time of writing, 

only a handful of places have 

outlined their stance on self-

driving cars on their roads, and 

as you’d expect, the criteria is 

going to be tough to navigate 

through. It’s been reported that 

Apple has made great strides 

in getting oficial conirmation 
to test its cars in 

California, and 

it’s likely that’s 

where we’ll see 

the irst version of 
Apple’s car make 

its debut. When 

it then comes to 

launching ‘Project 

Titan’ overseas, 

there’s no real word on how 

long, or how dificult the whole 
process could be. Regulations 

have already halted progress of 

self-driving cars in and around 

Europe, so Apple has a lot of 

work on its hands already.

Apple’s plans for its own 

self-driving car may seem 

overly ambitious at times, but 

it’s certainly no longer a pipe 

dream. Sure, there are a lot of 

regulations, hazards and other 

obstacles to still overcome, but 

the fact that we could all soon be 

in an automated car controlled by 

our iPhone is very, very exciting.

9
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#Trending

Things we learned 
this month

Apple makes iWork  
apps free for all users   iWork

Apple Music introduces  
‘Up Next’ feature  Apple Music

Apple has recently announced plans to integrate 

a new ‘Up Next’ feature into its Music service. 

The new feature is designed to help promote the 

next generation of musicians, with each month 

showcasing one particular artist. Akin to what Apple has done 

previously, it’s believed that ‘Up Next’ will also be used to 

promote certain albums, especially those that are launching 

exclusively on Apple Music. The first ‘Up Next’ artist getting 

the Apple treatment is rapper 6LACK, whose entire library has 

been made available through the streaming service.

Apple has updated several of its 

key Mac and iOS apps, making 

them free for all iOS and Mac users. 

Previously, iMovie, GarageBand, 

Numbers, Keynote and Pages would have only 

been free for those who had purchased a new 

Mac or iOS device – however that is no longer 

the case. For new users who are interested in 

these apps, Apple has been quick to point  

out that you’ll need a few GB of available 

storage to download the entire suite, which 

won’t be good news for those using Apple’s 

entry-level hardware. 

Meanwhile, for a complete guide to using 

Pages, Numbers and Keynote from Apple’s 

iWork suite of apps, be sure to check out our 

iWork for free! feature, starting on page 14.
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Nike+ Apple Watch 
gets all-new upgrade

It has already been seven months since we saw 

the initial release of Nike’s attempt at its own 

branded Apple Watch. Although tailored for use 

by fitness fanatics, the new Watch gained rave 

reviews from many. 

To build on that initial success, Nike has now 

announced a new special edition Apple Watch, 

with an exclusive new band colour. Touted as 

the Apple Watch NikeLab, large parts of its 

design are the same and it includes the same 

waterproof coating that has made previous 

models successful. The biggest change is 

the exclusive, off-white coloured strap, with 

aeration holes provided for ventilation and 

sweat management for fitness lovers. This  

adds another colour option to the numerous 

other straps that have been designed by  

Nike previously.

The Apple Watch NikeLab will only be 

available in small quantities from early May and, 

while Nike hasn’t revealed its pricing, like the 

other models in the Apple Watch Nike +  

line-up, it’s expected to be launching around 

the £369/$399 mark.

“The biggest change is 
the exclusive, off-white 
coloured strap”
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Search Ads service 
launching in UK  App Store

Search Ads have proven to be an integral 

part of the App Store for US users, so 

much so, that Apple is now bringing them 

to the UK. These targeted adverts work 

within the iOS App Store app, allowing for app-based 

adverts to target specific users. The service has 

been used to help promote apps built by small and 

independent developers, and it’s believed that this 

same focus will apply to its UK expansion. For those 

interested, keep a look out for an upcoming App Store 

update, which will include this new wave of adverts.

New high-end iMac  
launching later this year  iMac

According to a new insider report, Apple’s latest range of iMacs will be launching 

later this year. The biggest news expected from the launch will be a new 

‘server-grade’ model, which is tailored for use in the high-end 

creative market. This new model will include Intel’s 

as-yet-unreleased Xeon processor and 2TB of 

onboard SSD storage. Alongside the new iMac 

models, it’s likely we’ll also see a brand new 

keyboard from Apple, and one that 

integrates both the Touch 

Bar and Touch ID 

features found 

in other Apple 

hardware.
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5
As we know, no official instruction manual comes with any Apple 

product, so we have to feel around to find out the inner workings of 

our Macs, iPhones and iPads. This can be great fun as it seems that 

there are always new tricks and time-savers hidden away within macOS 

and iOS for us to discover and use to our advantage. For this month’s 

projects we take a quick look at three such gems to help us get the 

most out of certain apps and features of our devices.

MINUTE PROJECTS
TO TRY TODAY

3

1 2

#Trending

It’s always good to 

have a calculator 

on hand, and your 

iPhone supplies the goods. 

However, the app lacks 

a button on the compact 

keyboard to delete numbers 

if you make a mistake. Is 

pressing ‘C’ the only option? 

No, as it happens…

1  Delete digits  
in Calculator

1 Launch 
the app
You can launch 

the Calculator 

app on your 

iPhone by 

tapping the app 

icon on your 

home screen 

or swiping up 

and accessing 

it from the 

Control Center.

2 Enter 
numbers
Start typing 

numbers into 

Calculator and 

you should 

notice that 

there isn’t a 

button to delete 

digits, only  

the clear-all ‘C’ 

button. But it  

is possible…

3 Swipe 
left or right
That’s right, a 

good old swipe! 

Simply swipe 

left or right 

across the top 

of the screen 

and digits will 

be removed 

one at a time 

until there are 

none left. Easy.

If you are sticking 

fast with the free 

5GB of iCloud 

storage allocation for every 

user then it won’t take long 

to fill up with backups and 

documents. However, you 

can manually manage what 

is stored in your cloud and 

free up space, if needs be.

2  Manage your 
iCloud storage

1 Go to Settings
Launch your iPad’s Settings app and 

then tap on General>Storage & iCloud 

Usage. This will give you an overview of 

the storage on your device and iCloud.

2 Manage storage
Now, in the iCloud section, tap on the 

‘Manage Storage’ option and everything 

that eats into your iCloud storage will be 

listed, from backups to emails.

3 Delete data
You can now delete old backups that 

you don’t need and tap on individual 

apps that upload documents and data 

and manually remove content.

The addition of Siri to 

macOS can greatly 

speed up the time it 

takes to change certain basic 

settings of your Mac. Launch 

Siri and start asking for 

various System Preferences 

to be changed to save you the 

hassle of launching the main 

settings in the first place.

3  Use Siri to 
change settings

1 Activate Siri
Call up Siri on your Mac by pressing 

Cmd+Spacebar. You can change 

this shortcut by going to System 

Preferences>Siri.

2 Adjust the brightness
Now you can say things like, “Turn 

up the brightness” and Siri will 

automatically make your screen brighter. 

It’s a handy time-saver.

3 Other functions
You can also say things like, “Turn on 

Bluetooth” and Siri will oblige. Once 

you get into the habit of asking, Siri can 

save you a lot of time here and there.
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Become an instant expert in Apple’s iWork suite of productivity apps

iWork for free!

A
s of April, somewhat stealthily, Apple updated 

and made its iWork suite of apps – Pages, 

Numbers and Keynote – totally free to download 

on macOS and iOS. Previously, all of these apps 

were only provided for free to customers who purchased 

a new Mac or iOS device, but now that purchase is not a 

prerequisite for getting the apps. This is great news for your 

productivity because you can start creating documents on 

your Mac, pick up where you left off on your iPad or iPhone 

and even collaborate on documents with other people. 

All three apps are incredibly easy to use because they 

come with a wide range of templates that you can use 

as a basis for your own documents, replacing all existing 

elements but retaining the same themes and layouts. 

Alternatively, you can create your own documents, 

spreadsheets and presentations from scratch, using our 

iWork for free!

expert tips to delve into some of the lesser-known features 

of the iWork apps. For the purposes of this feature, we have 

focused mainly on the macOS versions of these apps, but 

the iOS versions are just as easy to use. The key difference 

is in the interface and how you access certain features. 

For example, in the iOS versions you will need to tap the 

paintbrush icon for all of your formatting needs and the ‘+’ 

icon for adding additional elements to your documents, 

such as tables, charts, shapes and images. For all other 

features, such as the option to collaborate with others, tap 

the ‘…’ icon. It will only take you a few minutes to adjust to 

the different ways of using the apps.

Over the following pages we will provide numerous tips 

and tricks for Pages, Numbers and Keynote to help you 

become instant expert in minutes. So read on to discover 

exactly what you never knew you could do.



Pages
Get to know templates, create 

your own custom styles and 

start laying out pages like a 

seasoned pro!

Using templates
If you opt to use a template to create a Pages 

document, you can click on existing dummy 

text to replace it with your own and click on the 

picture icons within the images to import your 

own. The app links to the Photos app so finding 

images from your own collection shouldn’t 

be a problem. You can also click and hold to 

drag the various text boxes and picture frames 

around the page to personalise it more – hold 

down the Command button to temporarily 

remove the Snap Guides. If you click on the 

Format icon in the top-right you can use the 

Style tab to add borders and shadows to 

images to make them really stand out.

1 Add a table or chart
First, click on the respective button at the top of 

the interface to choose a table or chart. If you 

are inserting a chart you can choose from 2D, 

3D or interactive. 

2 Edit chart data
Once on the page, click on the chart to drag 

it into position and then simply select the ‘Edit 

Chart Data’ option underneath in order to insert 

your own data.

3 Create your own formulas
Tables come with all of the functionality of the 

Numbers app in that you can create your own 

formulas. Click on a cell and tap the ‘=’ key to 

get started.

Using tables and chartsStep-by-step
If you are putting together reports then you may wish to 

illustrate them with tables and charts. Here’s how…

Customise your page
Changing the style of your text is easy  Using Styles

You can format text quickly and 

easily by clicking on the Format 

button followed by the Text tab.

 Current style
The current text style 

will be displayed at the 

top of the Text column.

 Changing style
Click on the drop-down 

menu next to the current 

style to reveal the other 

text formats available.

 Other styles
If you click on a 

new paragraph style 

you can instantly 

format the currently-

highlighted text.

15



iWork for free!

Create custom styles
If none of the styles in a template are to your 

liking, create your own custom styles. Click 

on ‘Format’ and select ‘Text’. Under the ‘Font’ 

section you can change the font style and 

weight of the text, adjust the colour, use other 

character styles and change the size. When you 

are happy with your adjustments, click on the 

drop-down menu next to the improvised text at 

the top of the column and then click on ‘+’ next 

to the ‘Paragraph Styles’ header. A new style is 

created based on your selections and added to 

the list and highlighted so you can rename it. 

Back to front
As you may discover, some 

elements may be hard to 

place at first. For example, 

if you have positioned an 

image on your page and are then trying to 

position a shape, such as a circle, in the top 

corner of the image, you may find that the 

shape disappears behind the image. To get 

around this, and to ensure that you are always 

working on the right element, select the item 

and then click on ‘Front’ in the Arrange menu to 

bring the item to sit on top of the image.

How to add media 
Import music and videos into your documents

 Interactive 
documents
Importing music 

and videos provides 

interactive elements to 

your documents.

 Drag and drop
You can position 

movies and sound files 

anywhere on the page 

by clicking and dragging 

them around.

Manipulating elements
If you have applied images, shapes and other 

elements to your documents and wish to rotate 

them, you can group items together and rotate 

them simultaneously. To do this, click on the 

‘Arrange’ tab in the Format menu and then 

select the items that you wish to rotate. Now 

click on the ‘Group’ option near the bottom of 

the menu and then use the Rotate tool to apply 

the desired degree of rotation. Once you have 

made your adjustments you can click on the 

‘Lock’ button near the bottom of the Arrange 

menu to secure all of your elements into place.

 Add media
You can add your 

own pictures, videos 

and music to your 

documents by clicking 

on the Media button.

 Select media
Use the tabs to switch 

between media sections 

and navigate to the item 

you wish to incorporate.

16
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Gradient Fill to create 
unique, Instagram-style 
filters for your images”



If copying content from the internet, you can match the current style when 
pasting it into a Pages document by pressing Shift+Option+Cmd+V.

1 Reduce the size
If you intend to email a document to someone 

then you may have to reduce the size. To do 

this, go to File>Advanced>Reduce File Size.

2 Email documents
Now go to File>Send a Copy>Mail. The file will 

be attached to a blank Mail document for you 

to then fill in the recipient(s) and details.

3 Collaborate with others
You can now collaborate on Pages documents 

with other people. Click the ‘Collaborate’ 

button, choose a method and set privileges.

Sharing your Pages documentsStep-by-step
If you want to collaborate on a project, it’s easy to share 

documents and set up collaboration privileges. Here’s how…

Wrapping text
If you wish to wrap text around an object, such 

as a shape or image, click on the Text Wrap 

menu and choose your desired style from the 

drop-down menu, such as ‘Around’ or ‘Above 

and Below’. This will help give your documents 

a more professional appearance and reduce 

dead space anywhere on the document.

Add comments
If you are collaborating on documents with 

other people then something you will no 

doubt find useful is that you can add your own 

comments to the document by clicking on the 

Comment button at the top of the interface. 

This will bring up a comment box applicable 

to whichever element you currently have 

highlighted on the document. If you have added 

multiple comments to the document then you 

can cycle through them by clicking on the 

left and right arrow icons within the comment 

boxes. The comment boxes will vanish from 

view when you click away from them, so simply 

click on the small coloured box in order to 

make them reappear. 
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Create filter effects
You can utilise the app’s Advanced Gradient Fill 

to create unique, Instagram-style filters for your 

images. Click on the Shape button and then 

pick the rectangle shape from the menu. Once 

on the page, click and drag the corners of the 

shape to overlap the image and then select a 

colour for the shape from the Style tab in the 

right-hand column. Now it is simply a case of 

reducing the Opacity scale using the slider and 

the image will become visible behind the shape 

with whatever strength tint you choose. You 

can also change the ‘Fill’ option to ‘Gradient 

Fill’ and select the colours of the gradient – you 

can certainly create some very eye-catching 

effects using these methods.



iWork for free!

Numbers
Experiment with formulas, format your tables and charts 

and present your data as cleanly as possible

Enter your data
Entering text and figures into 

Numbers is easy. You can freely 

input data into the cells of a blank 

spreadsheet. If the data you are 

entering needs to be in a specific 

format then click on the Cell tab 

in the Format menu and click on 

the Data Format menu to choose 

the style, such as plain ‘Text’, for 

example. Click on the Text tab 

in the Format menu to style the 

text, change the colour and align 

it within the cells. If you wish to 

quickly style your table up into a 

particular theme, click on the Table 

tab in the Format menu and you 

will see a variety of different table 

styles at the top – then you can 

click on one to instantly apply that 

style. If you have styled up your 

own unique table, click the right 

arrow and then the ‘+’ icon to  

add your current style so you can 

reuse it later. 
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Calculate values
Insert Functions to your table

Once you have finished working on a document it will be automatically 
saved to the Pages, Numbers or Keynote folder in your iCloud Drive. 
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1 Quick calculations
If you highlight a number of different cells 

within your table then you can view a number 

of common calculations related to them at the 

bottom of the screen.

2 Edit chart data
There are various functions available – the 

SUM function is particularly popular as it 

simply adds up the figures of the highlighted 

cells to present a total. 

3 Drag and drop
If you want to use one of the functions 

displayed at the bottom of the screen, you 

can simply drag and drop it into a spare cell 

within your table. 

Adding functionality to your tablesStep-by-step

It is easy to add quick formulas and calculations to your tables. If you wish to change the common calculations displayed, 

click on the arrow next to the small settings icon and then select different calculations to display from the extensive menu.

 Opening the 
Functions menu
To open up the full Functions 

menu, type ‘=’ into a cell.

 Pick a function
You will now be able to scroll 

through the Functions menu 

to pick a calculation.

 Insert Function
When you have found a 

Function to use, click on the 

‘Insert Function’ button.

 Select cells
Finally, highlight the cells 

that you wish to include in 

the calculation.



iWork for free!

One size fits all
One of the most convenient features of 

Numbers is the way in which you can use the 

Functions menu to apply a particular calculation 

to a cell then, once done, copy and paste the 

formula to another cell. When done, only the 

calculation method is copied, not the actual 

contents of the cell. This is a great time-saver 

when putting together spreadsheets.

Don’t forget that you can also easily trim the 

fat from your spreadsheets to only present the 

cells that matter. To do this, simply highlight 

the rows and columns that you don’t want and 

then right-click. Now select the ‘Delete Row(s)’ 

or ‘Delete Column(s)’ options from the menu 

and the excess flab will be removed from your 

spreadsheet. If you then find that you need 

additional rows and columns later, just click on 

the ‘=’ icons in the bottom left and top-right 

corners to instantly add more.

Merging cells
If you happen to have a lot of text that you 

want to fit into a particular cell then, rather 

than having it spill out of the sides and be 

illegible until you click on the cell and physically 

highlight the text, you can simply select two or 

more cells next to or above and below each 

other, right-click (or click on the ‘Table’ menu 

at the top of the screen) and then choose the 

‘Merge Cells’ option. This will create one big 

cell which provides more room to type the text 

into so you can present it to the reader in a 

much clearer way. 

“You can copy and paste the 
formula to another cell – a 
great time-saver when putting 
together spreadsheets”
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Give your tables names
If you are presenting multiple tables within the same spreadsheet then it is important 

that you name them so that people know what they represent when viewing the 

spreadsheet. To do this, highlight the table and click on the ‘Table’ tab in the Format 

menu. Now ensure that the ‘Table Name’ box is ticked and a generic ‘Table 1’ name 

will appear above your table – simply click on this and then replace it with whatever 

title you deem appropriate for your table. Repeat this for all of the tables in your sheet.



Know your 
Numbers
Find your way around 
Numbers’ various functions

 Add charts
You can add a chart to 

present data from a table by 

clicking this option and then 

picking a type of chart to use.

 Add comments
If you are collaborating on sheets with 

other people, add your own comments 

by selecting this option.

 Adding media
You can add photos, movies 

and sound files to your 

spreadsheets by clicking on 

the ‘Media’ button at the top 

of the interface.

 Collaborate
To work on projects with 

other people, click on this 

button and choose a method 

of connecting.

Numbers operates a bit like predictive text in that it 

will analyse what you are entering into a particular 

cell and then try and assist for subsequent cells. 

For example, if you type a currency sign, such as 

‘£’ or ‘$’ into a cell then the application guesses 

that you are adding currency values and so formats 

the numbers appropriately. However, this can be 

somewhat annoying if you want to add in numbers 

beginning with zeros or you want to be a little more 

freeform in the data you input into a particular cell – 

but there is a simple way to get around the issue, as 

demonstrated here.

1 Enter your data  
Click on a cell that you wish to enter data into and then click on the ‘Cell’ tab 

within the Format menu. Click on the ‘Data Format’ menu and you will see 

an array of options that you can apply for your cell. If you want to ensure that 

whatever you enter is kept in the format you enter it in, select the ‘Text’ option 

from this menu.

2 Make your choice 
To apply your chosen format to numerous cells, hover your mouse over the cell 

you formatted and a small yellow dot will appear at the bottom of it. Click and 

hold on this dot and then drag it down over the cells you also wish to apply your 

data format to. When you release, the data format will be applied to all of the 

selected cells.

Overriding automatic data formats

In Numbers, if you hold down the Alt (Option) key and use the arrow keys, 
you can quickly add rows and columns around the currently-selected cell.

21



iWork for free!

Using Instant Alpha
You can easily remove the background from an 

image using the Instant Alpha tool, if the image 

in question has a strong enough background. 

To start experimenting with what you can do 

with Instant Alpha, place an image into a slide, 

click on it and then select the ‘Image’ tab in 

the Format menu. Here you will see the Instant 

Alpha option, so click on that and a reticle will 

appear over your image. You can now position 

the reticle over a portion of the background 

and then click and drag to highlight it. Once 

you let go of your mouse, the background will 

vanish. This is handy if you only wish to display 

a portion of your image and perhaps want to 

place text in the area you are masking off.

Editing Master Slides
You can create a unique-looking presentation 

by picking a Gradient theme from the templates 

and then editing the master slide to a different 

colour. Start off by picking your gradient 

theme and then click on the ‘Edit Master Slide’ 

option in the Format menu. Now change the 

Background option to ‘Gradient Fill’ and use 

the two colour picker options to set the colour 

at the top of your slide that graduates down 

into the other colour at the bottom of the slide. 

Click on ‘Done’ once you have finished and 

you will be able to use this graduated style 

on all subsequent slides that you add to your 

presentation to make something unique.

Create masks from shapes
You can create eye-catching presentations by 

dropping images into shapes. Use the Shape 

menu at the top of the interface to pick a shape 

and then once it has been placed on the page, 

simply drag and drop an image into it. You can 

then use the masking tool at the bottom of the 

interface to determine what is framed within the 

image. Once you have finished, click ‘Done’ 

in the masking tool and everything not framed 

within the shape will be hidden. Shapes can be 

very handy for framing pictures and you can 

build up stunning looking images using this 

process to make your slides truly captivating.
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Keynote
Create eye-catching slides, animate the components 

and use your iPhone to present your slides



Add links to slides in a Keynote presentation by selecting the text, clicking 
on the ‘Format’ menu bar item and choosing the ‘Add Link’ (Cmd+K) option.

Use your iPhone as a remote
If you have the Keynote app installed on 

your iPhone then you can use it as a remote 

control to operate the presentation on your 

Mac. To set this up click on the Keynote menu 

item and choose ‘Preferences’. Now click 
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1 Select Magic Move
Click on the ‘Animate’ option in the top-right 

corner of the interface, then click on the ‘Add 

an Effect’ option and select ‘Magic Move’ from 

the top of the menu.

2 Tweak options
When you have applied Magic Move to a slide 

you are then presented with various options 

so that you can tweak the effect so that it suits 

your requirements. 

3 Animate items
You can also apply individual animation effects 

to all of the items within a slide. Click on ‘Build 

Order’ to determine the order of effects once 

you have applied them.

Magic MoveStep-by-step

A great way to add a spot of pizzazz to your 

presentation slides and make them instantly 

more captivating to an audience is to utilise  

the Magic Move feature of Keynote. Magic 

Move determines how each of your slides 

transitions into the next. 

Animate in Keynote
Bring your presentation to life with animations

 Pick an animation
There is a wide array of different 

animations and all can be 

previewed before selection.

 Adding animations
Select an item on the slide and 

then click on the ‘Animate’ icon 

in the top-right corner.

 Tweak animations
Depending on the style of 

animation, you can select 

directions and duration to suit 

your needs.

 Build order
If you add numerous animations 

to one slide you can edit the 

order in which they take place.

on the ‘Remotes’ tab within the Keynote 

Preferences menu, ensure that your iPhone 

is displayed (you may need to update the 

app on your iPhone) and then place a tick 

in the ‘Enable’ box. You will now be able to 

control your presentation remotely.
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Shoot, import and edit photo bursts

It can be a challenge when you want to photograph fast-

moving subjects such as children or pets. One way to increase 

your chances of capturing an effective image is to use your 

iPhone’s burst mode. This rapid fire option swiftly captures 

a series of consecutive stills. You can than peruse a burst of 

images in your iPhone’s Photos app and select the best ones 

to keep there and then. However, it can be tricky to tell which 

photographs are the best when viewed on the iPhone’s small 

screen. It’s also more fiddly to edit on an iPhone. Here we show 

you how to shoot a burst on your iPhone and then transfer all 

its contents to your Mac’s Photos app to view and edit.

Get the perfect shot by editing iPhone-sourced photo bursts using your Mac’s Photos app

Photos

Download available

Time needed

10

Difficulty

Shoot and edit Photo burstsStep-by-step

1 Capture a burst 
In iPhone’s Camera app, hold your finger down 

on the shutter button to capture a series of 

consecutive shots. A counter will indicate the 

amount of photos captured in the burst.

2 View the burst 
In your iPhone’s Photos app, tap on Albums. 

Here you’ll find a Burst folder gathering all the 

bursts you’ve shot. Tap on a burst’s thumbnail 

then tap ‘Select’ to view its contents.

3 Select all shots 
Instead of choosing favourite shots on the small 

screen, tap every shot in the burst to select it 

with a check mark. Tap ‘Done’ to keep every 

image for viewing later on your Mac.

4 Share the shots
Go to Moments. All the selected shots from the 

burst will now be visible as individual images. 

Tap ‘Select’. Swipe over the shots to quickly 

select them. Tap the Share icon, then ‘Next’.

5 Import using AirDrop
Tap the AirDrop icon to send the burst photos 

to your Mac. (Make sure your iPhone’s Wi-Fi 

and Bluetooth functions are turned on in the 

Control Center so you can use AirDrop.)

6 Import into Photos 
Drag the shared photos from your Downloads 

folder onto the Photos app icon in the Dock. 

Tick ‘Import All New Photos’. The shots appear 

as a burst in Photo’s Last Import album.
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If you can’t use AirDrop, plug your iPhone into your Mac. Click the iPhone 
icon in Photos. Shift-click to select all burst photos. Click ‘Import Selected’.

Choose your best shots
Keep your favourites and delete the duffs

 View burst contents 
After double clicking on a 

thumbnail in the Bursts album 

you can view the contents of 

the selected burst in Photos’ 

large display.  All the photos in 

a burst appear as consecutive 

thumbnails here. Favourited 

shots will feature a check mark.

 Quality control 
After ticking the best shots in a burst, click ‘Keep 

Only Selection’. The remaining photos will no longer 

appear in the Bursts album. You can access and 

edit your favourited shots in the All Photos album.

 Swipe through 
Click here to flick through 

the contents of a burst 

in the main window. 

Alternatively you can 

swipe left or right on your 

Magic Mouse or use your 

MacBook’s touchpad.

 Make your choice 
By viewing images on your Mac’s larger screen you 

can tell if a shot is in focus more clearly than on an 

iPhone. If you like particular shots tick this circle.

7 Go to Bursts album
After importing the contents of a burst via USB 

cable or AirDrop, Photos will stack them into a 

pile indicated by a thumbnail. Access all your 

imported bursts by clicking the Bursts album.

8 Choose the best shots
Double click a thumbnail. Click ‘Make a 

Selection’. Tick the best images at their bottom 

right. Click ‘Keep Only Selection’ to favourite 

the best shots and lose the rejects.

9 Edit your favourites 
You’ll find your favourite burst shots as 

individual images in the All Photos album. 

Tweak their colours, tones and composition on 

your Mac by clicking the Edit Photo icon.

 Knowledge base

Faster shooting 
Your iPhone isn’t the most 

efficient gadget when it comes 

to capturing photos of a 

spontaneous event. You have to 

unlock it and tap on the camera 

icon before you’re ready to 

compose the image and trigger 

the shutter. By then the photo 

opportunity may have passed. 

You can quickly access the 

camera without unlocking the 

iPhone by swiping your thumb 

to the left.



Creating teleportation effects

Teleportation is a sci-fi special effect that’s been around since 

the early days of cinema. The teleportation technique is easy 

to produce in iMovie. You shoot a subject on location and then 

shoot the same location without your subject present. You then 

use an iMovie Cross Dissolve transition to mix between the two 

shots and make the subject magically appear out of thin air. 

Variations on this simple cross-fade editing technique have 

been used for decades to make the Tardis materialise or bring 

Captain Kirk to new planet. Traditionally most teleportation 

effects were statically framed because the camera couldn’t 

be moved without spoiling the mix effect. To make your 

teleportation look more convincing we’ll add a post-production 

camera move to enhance the effect.  

Create a classic sci-fi materialisation scene using transitions

iMovie

Download available

Time needed
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Create convincing effects
Fine-tune your teleportation effects using the Precision Editor and the Ken Burns effect

 Knowledge base

Teleport shooting tips
When shooting your own 

teleportation source clips, make 

sure that the only thing that changes 

between shots is your materialising 

subject. Avoid windblown trees in 

the background for example. Set 

your camera’s focus and exposure 

to manual to avoid changes in 

lighting or focus during the dissolve. 

A low angle like the one we used will 

avoid stray people materialising in 

the background.

 Export and import  
After adding a cross dissolve to 

make the actor materialise, we’ve 

exported a version of the statically 

framed scene. We can import this 

version into iMovie and add a camera 

move using the Ken Burns effect.

 Finishing touches 
No TV teleportation would be 

complete without an accompanying 

sci-fi sound effect. Go to the Audio 

panel and experiment with the 

sounds in the Sci-Fi folder. We 

preferred Warp Engineering 02. 

 Transition
This Cross Dissolve 

transition causes a mix 

from the empty location to 

the clip featuring our actor. 

As the actor is the only 

thing that changes during 

the mix he appears to 

materialise out of thin air.

 Video layers  
In the Precision editor we 

have two video clips. On 

the top layer there is a 

clip which features a city 

location. On the bottom 

layer we have the same 

scene but this time with 

our actor present.

Difficulty
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Download available
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Shoot your sequences as a single video clip so the background doesn’t 
become misaligned when you tap the camera to start and stop recording.

Create a teleportation effectStep-by-step

1 Import assets
In the Media tab click ‘iMovie Library’. Choose 

File>New Event. Label it ‘Teleport Event’. Click 

‘Import Media’. Go to our project’s Teleportation 

Source Clip. Click ‘Import Selected’. 

2 Add clip to timeline 
Click on the imported clip in the My Media 

panel. Click the thumbnail’s + icon to add the 

clip to the timeline. Our subject is in shot and 

then leaves the frame to display the city towers.

3 Split the clip
Scrub the playhead until the man leaves the 

frame. Right-click and choose ‘Split Clip’ from 

the context-sensitive pop-up menu. This cuts 

the clip into two sections. 

4 Swap the clips
Drag the second section (featuring the empty 

location) and place it at the start of the timeline. 

Play the sequence. The man will suddenly 

appear due to the jarring jump cut.

5 Add a transition 
Drag the start of the second clip right to trim a 

few seconds from the man standing still. Go to 

the Transitions panel and drag a Cross Dissolve 

between the two clips to make him materialise.

6 Change duration  
The default duration of the dissolve is 1.0 

second. If you double-click on the dissolve to 

try and increase its duration you get a message 

saying it isn’t possible due to the short length.

7 Precision editor 
Go to Window>Show Precision Editor. The 

dissolve will appear as a separate layer 

between the two clips. Drag the start of the 

dissolve left to extend its duration to 2 seconds.

8 Export the clip
Choose File>Share>File. Set Resolution to 

1080, Quality to Best (Pro Res) and Compress 

to Better Quality. Click ‘Next’ and choose a 

destination for your file (such as the Desktop).

9 Add a camera move
Choose File>Import Media. Browse to the 

exported clip. Replace the timeline clips with 

the imported version. Go to Cropping. Choose 

‘Ken Burns’ to zoom in as the man appears. 
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Sky replacement techniques 

In TV dramas and Hollywood movies it’s common practice to 

replace a bland overcast sky with a more interesting one. In this 

walkthrough we’ll demonstrate how to use a simple masking 

technique to combine two layers of video together to replace 

a cityscape’s flat and featureless sky with a more textured 

cloudier version. You can download the replacement sky and 

landscape footage we’ve used, or follow the steps using your 

own footage. We’ll show you how to tweak contrast to tease 

out more detail in the replacement sky. You’ll also learn how 

to grade both layers of video to give them a unifying wash of 

colour, and turn daytime footage into a striking sunset. 

Use layers, a graduated mask and grading to replace a dull sky with a more interesting one

Final Cut Pro X

Download available

Time needed
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Make the most of masks
Use a mask to combine parts of parallel video layers

 Knowledge base

Masking limitations
The masking technique used in our walkthrough 

works well if the landscape and replacement 

sky occupy separate sections of the frame. 

However, if a tree or tall building extends into the 

top half of the frame it will disappear when the 

mask overlaps. In that scenario it may be worth 

experimenting with a Keying effect to replace the 

original sky with a new sky on the layer below.

 Compound clip 
Once our sky and ground 

layers have been mixed 

together using a graduated 

mask we can merge them 

together into a single 

compound clip. We can then 

grade the compound clip’s 

colours and tones to unify 

the separate components.

 Fine-tune the gradient 
We’ve used the Graduated Mask’s 

control points to tilt the gradient 

so that the sky doesn’t overlap the 

angled bridge. We’ve also increased 

the length of the gradient for a more 

gentle blend between the original 

sky and its replacement.

 Separate layers
For this project we shot two 

video clips. One clip contains a 

cityscape with a dull flat blue sky. 

The other clip features a more 

moody cloudscape. We can 

combine the clips using parallel 

layers and a mask.

 Graduated Mask
As its preview thumbnail suggests, this effect 

makes a video layer become gradually transparent. 

This enables us to combine sky from one layer with 

ground from another in a gentle and gradual blend.

Difficulty
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Replace a sky using masksStep-by-step

To summon (or dismiss) the Effects browser press Cmd+5, click on its icon 
or choose Window>Show in Workspace>Effects.

1 Import clips
Choose File>New Event. Label the event ‘Sky 

Replacement’. Tick the ‘Create New Project’ 

box. Click ‘OK’. Choose File>Import Media. 

Browse to select our supplied start files.

2 Add clips 
Click on the ‘Land’ clip in the Bin and drag it 

onto the Timeline. Drag the ‘Sky’ clip onto the 

parallel layer below. Play the footage. The solid 

top layer hides the sky on the bottom layer.

3 Add graduated mask 
In the Effects browser, click ‘Masks’. Drag a 

Graduated Mask onto the top layer. By default 

the mask will poke a hole in the bottom part of 

the landscape to reveal sky on the lower layer.

4 Manipulate the mask 
A Mask properties section shows in the 

Inspector, with two mask control handles in the 

Viewer. Drag the bottom control point above 

the top one to reverse the effect of the mask.

5 Fine-tune the mask
Drag the lower control point downward until 

the sky touches the top of the bridge. Drag the 

upper control point higher to create a wider, 

more gradual blend between sky and bridge.

6 Enhance sky contrast
Click on the Sky layer. Press Cmd+6 to show 

the Color Board. Go to Exposure. Set Shadows 

to -27%. Increase Highlights to 20%. Drop 

Midtones by -11% for a more dramatic sky.

7 Create a compound clip
To grade both layers equally we need to 

combine them. Shift-click on the layers. Right-

click and choose ‘New Compound Clip’. Click 

‘OK’ to create the Compound clip.

8 Grade the colours
Click on the Timeline’s compound clip. Click 

the ‘Color’ section of the Color Board. Drag the 

Global control point to 24 degrees and 43% to 

add a sunset colour palette to the composite.

9 Add a vignette
To combine the separate elements into a more 

coherent composite clip, go to ‘Stylize’ in the 

Effects browser and add a Vignette effect. 

Tweak the vignette using its control points. 
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How to use the Loop Library

GarageBand is probably the most accessible music creation 

platform across every device. The reason for this? In a word, 

the answer is loops and the enviable library of Apple Loops 

available out of the box. This growing collection of royalty-free, 

professionally pre-recorded samples is pivotal to getting every 

user assembling impressive, harmonious songs within minutes. 

They can similarly be used to quickly build backing tracks to 

perform and record alongside, with an array of beats, melodies 

and even vocal lines to choose from. All these sounds are 

indexed, browsed and searched via the intuitive Loop Browser 

panel packed with tools to make discovery a breeze. 

Navigate GarageBand’s best sound samples with the Loop Library browser

The Loop Library in actionStep-by-step

GarageBand

Download available

Time needed
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Difficulty

1 Show the Browser 
With GarageBand launched and a project open, 

the first step is to show the Loop Browser. Click 

the second Apple Loops button in the top right 

or use the O key shortcut.

2 Viewing every loop
The browser starts with a View pop-up menu. 

By default, ‘Loops’ should be selected to 

search every installed, indexed loop in your 

library or just a listed sub-category.

3 Quick search field 
A Spotlight-like search field is found below. 

Here you can type the name of a known loop or 

click the magnifying glass icon to view a menu 

of recent loop searches as shown.

4 Keyword view 
Two small buttons below toggle between 

Keyword buttons or columns. Keyword buttons 

allow you to click on multiple instrument and 

genre filters and search matching loops.

5 Keyword buttons
So for EDM-style drum loops, for example, we 

might select the Beats and Electronic buttons. 

You might then add Processed, Distorted or 

Intense options to narrow further.

6 Keyword columns
The columns view categorises loops similarly, 

instead using tiered keyword categories such 

as Genre, Instruments or Moods. As you 

navigate, the results list below updates.
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The Browser’s Scale drop-down menu filters those melodic loops that follow 
major or minor scales, and indeed those that work for both or neither. 

Inside the Browser
We pick out the key areas of the Loop Browser and the tools for searching through samples

Apple Loop types
As you’ll see from a quick 

browse, there are two types 

of Apple Loops in the library. 

Those shown with a green icon 

are software instrument loops 

that can be edited like MIDI 

regions – in other words, edited 

note for note. Blue loops are 

audio recordings and can only 

be added to audio tracks, as 

regions that are editable as 

waveforms only.

 Knowledge base

 Search field
Quite simply, you can type here to 

search for a desired loop by name. If 

you perhaps already know of a particular 

Apple Loop, you can call it up directly 

here rather than browsing more generally.

 View pop-up & buttons 
At the very top of the Loop Browser 

is a View pop-up menu that selects 

the whole library or between 

installed collections or Jam Packs. 

Buttons below then toggle between 

column and keyword button views.

 The results list 
Based on your search filters, 

matching loops are listed 

here. They can be reordered 

by Name, Beats or Key by 

clicking the column headings, 

previewed and dragged out into 

the Tracks area to add.

 Keyword buttons
This bank of buttons can be 

customised, but by default 

they can be toggled on to 

filter a loop search to certain 

types or genres. Use the 

reset button to clear any 

applied filters.

7 Preview the results 
Loop matches are shown in the results list 

and can be reordered by Type, Name, Beats, 

Tempo or Key headings. Click a loop to 

preview, using the slider below to set volume.

8 Choosing a favourite
While browsing, you may find various loops you 

like and wish to mark for quick return. Select 

the checkbox in the ‘heart’ column to add a 

loop to the favourites category.

9 Drag to Tracks
Tempo and Key attributes signify recommended 

usage, but any can just be dragged out and 

dropped into the Workspace. They will adopt 

the project’s tempo and key by default.
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Automate auxiliary sends

It’s always a joy when an app is updated so that you can do 

something you’ve always wanted to do. Such is the case with 

Logic Pro X 10.3 and the automation of auxiliary sends in the 

mixer. Prior to this version, the automation system could control 

changes to the level of the send but not its on/off status – the 

workaround was to replicate turning the send off by drawing 

instant drops in send level to zero on the automation curve, 

while re-enabling the send was achieved by using the curve to 

return the control to its previous level. That’s all history now, as 

the facility exists to turn the send on or off directly – a much 

quicker way to generate spot effects at specific moments. 

Get quicker spot effects using automation in Logic 10.3

Logic Pro X

Download available

Time needed

20

Difficulty

Create Spot FX with automationStep-by-step

1 Import audio
Let’s get started by importing the audio file 

named ‘Software Sidechain Drums.aif’ (found 

in the Tutorial Files folder) into an empty Logic 

project at 126bpm.

2 Create send
Now in the track’s channel inspector, click 

on the Send slot and select ‘Bus1’ from the 

pop-up menu. This will then set up a send to 

Auxiliary Bus 1.

3 Add delay 
The right-hand channel in the Inspector pane 

will now be showing the return channel for the 

send you just created. Click on its Audio FX slot 

and insert a Stereo Delay plug-in.

4 Turn it up
Select the ‘1/16 note’ preset and raise the 

drum channel’s send level up until you can  

hear plenty of the delay effect working in the 

return channel.

5 Enable automation
Press ‘A’ on your computer keyboard to enable 

Logic’s automation system. This displays the 

default automation curve, which controls the 

track’s volume.

6 Select parameter
Click on the button labelled ‘Volume’ and 

choose Main>Send Mute 1>Aux 1 from the 

pop-up menu, then click in the region to reveal 

the curve for the send’s on/off switch.
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Logic Pro 10.3 projects can now contain up to 256 busses, offering 
incredible scope for dedicating a single buss to a specific, one-off effect.

Sending good vibes
Effects sends are now more easy to turn on and off

 Knowledge base

Many happy returns
In Logic’s mixer, audio signals 

can be moved around or 

‘routed’ from one place to 

another, a bit like water in a 

plumbing system. You can 

send a signal from one channel 

via a ‘bus’ to a different ‘return’ 

channel on which you can 

insert an effect plug-in. The 

effect is heard only in the return 

channel, leaving the original 

channel unaffected.

 Read all about it
When you activate automation, 

the default mode is ‘Read’ mode, 

in which all automation moves 

programmed by moving control 

points on the curve are played back.

 Manual on/off
Audition the effect by clicking 

the send’s on/off button to 

enable or disable it manually. 

This is the control you’re 

automating with this technique.

 Track/Region-based
This button enables you to automate 

either the whole of the selected 

track, or individual regions. Simply 

click to switch between modes.

 Curve appeal
Even though it’s often more of 

a straight line, the graph that 

denotes the value of the current 

parameter as it changes over time 

is called the automation curve.

7 Mute point
Click the small window under the pan control 

and select ‘Muted’ to turn the send off for the 

entire track. You should see the curve react 

accordingly, jumping to the top of the region.

8 Marquee mark
To create a spot delay effect on the blip on 

beat 2-4-3, use the Marquee tool to define a 

selection between beats 2-4-3 and 2-4-4. Click 

the selection with the Automation Curve tool.

9 Border control
This creates two control points on the borders 

of the selection. Drag the left point down to the 

bottom of the region to turn on the delay effect 

for just that one beat.
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Sierra’s manage storage facility

Storage remains as fundamental as ever in computing and in 

an era of photos, videos, music and apps we all crave more. 

Despite pocketing devices boasting the sort of GB capacity 

that would have made Deep Blue blush, this fervent file 

retention now sprawls online – a move with useful implications 

for desktops too. With macOS Sierra, Apple has recognised 

this increasing storage flexibility by adding custom management 

tools for decluttering your system drive. Useful for improving 

performance, not least clearing room for more stuff, the features 

embrace iCloud and iTunes and can be tweaked to the max. So 

in this advanced guide we take a closer look…

Master the new storage management tools within Apple’s latest OS

Using macOS Sierra’s management toolsStep-by-step

macOS Sierra

1 About This Mac
From the macOS desktop, begin by navigating 

to and selecting Apple>About This Mac from 

the main Finder menu bar. The About dialog 

showing the Overview tab should be displayed.

2 Storage tab
Click ‘Storage’ to view connected devices. A 

colour-coded bar shows how the hard drive is 

populated, but click the ‘Manage’ button to the 

right to show the Recommendations box.

3 iCloud Storage
Click the first button and a prompt offers 

two checkboxes for storing desktop and 

documents files, plus any photos and videos on 

iCloud Drive and Photo Library instead.

4 Optimize options
Click ‘Optimize’ and checkboxes toggle 

automatic removal of watched iTunes videos 

and a choice between downloading new email 

attachments or none at all.

5 Trash talking
The third button is useful if you often have a 

brimming Trash basket. Turning this feature on 

will automatically erase those files that have 

been trashed for over 30 days.

6 Reduce Clutter
Click ‘Review Files’ to show the Documents 

item. Large Files and Downloads are shown 

ordered by size for selection and deletion, while 

File Browser offers folder navigation.

Download available

Time needed

27

Difficulty
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Hover your mouse over the drive percentage bar in Storage to view pop-up 
tool tips indicating how much disk space each section of files occupies. 

Unboxing macOS storage
We pick apart the key components and tools within Sierra’s new management utility

 Knowledge base

Downloadable content
The manage storage utility 

allows a number of files to be 

deleted that you can always 

download again. One such 

selection is Music Creation, 

where GarageBand’s Sound 

Library can be removed 

completely and easily 

re-installed through the app. 

Just like Mail attachments and 

iTunes content, these files can 

grow very large and are useful 

to lose when clearing significant 

space quickly.

 Optimize Storage
Click this button to take actions such 

as removing any locally downloaded 

iTunes videos once watched, such as TV 

episodes and feature films. Additionally, 

things like only your most recent email 

attachments will be retained.

 Trash & Clutter
Turn on this to toggle the automatic 

erasure of trashed items after a 30-day 

period. The Review Files button then 

shows redundant files or content that can 

be manually deleted to remove clutter.

 Store in iCloud
This option automates the shifting of 

all file and photo storage onto iCloud 

instead of local system drives. Only 

recently accessed documents and those 

optimised photos etc are kept on your 

Mac to maximise space.

 Recommendations  
and file types
The first item shows the 

Recommendations pane by 

default, containing the main four 

button-based controls. Below 

this are listed the various stored 

file types, iCloud and programs 

you can view to make more 

direct changes.

7 Deleting files 
If a little cross icon shows as you hover over a 

listed file, you can click this to choose the file 

for permanent deletion or the magnifying glass 

to view within Finder.

8 Applications view 
Under the Applications tab, you can again view 

installed apps by size and delete as desired. 

Clicking the ‘Open Applications’ button opens 

the folder within a Finder window.

9 iOS Files
Aside from the other items, iOS Files is useful 

for identifying old device backups and iOS 

installers. They can simply be deleted in the 

same way, using the cross icon.
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Use a second screen with your Mac

There are many ways in which you can improve your macOS 

experience, from adding extra RAM to changing the keyboard 

and mouse, but one of the most cost effective methods is 

to add a second screen to your setup. The benefits such 

a change offers are huge and with the cost of good quality 

monitors dropping all the time, you should be able to greatly 

enhance your Mac setup for a fraction of the cost of the Mac 

itself. We will show you how to physically add a second monitor 

and then how to set it up so that you can use both screens in 

a natural and efficient manner no matter what you need to get 

done. You will begin to see your Mac through new eyes.

Enhance your productivity and flexibility with a second screen when using macOS

macOS

Time needed

15 

Difficulty

Set up a second screenStep-by-step

1 Check your hardware
Check to see what connections your Mac 

has and search for a suitable video adaptor. 

USB should not be considered an option even 

though technically it can be used. 

2 Connect the screen
Power up the second screen, connect the 

correct adaptor to your iMac or MacBook and 

it should immediately display the home screen 

without icons. The setup is very easy.

3 Go to Preferences
The next step is to open System Preferences 

and to then ensure that your new monitor is 

listed. Click Displays/Arrangement and you 

should see two screens displayed.

4 More preferences
A second panel will be shown which is 

dedicated to your new screen. Here you can 

play with a few settings, but we would advise 

you to click ‘Color’ and then ‘Calibrate…’ 

5 Follow the steps
Take some time to follow each step to ensure 

that your new screen is set up correctly. Try to 

make the light levels and colour tones identical 

on each to save eye strain. 

6 Working together  
You can now explore the true benefits of 

working with two screens. You will be able 

to drag windows and apps between screens 

instantly and double your working environment.
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You can also mirror your main Mac screen to display the same information 
on each – useful when working with another person on the same project.

A bigger playing field
Two Macs for the price of one

 Knowledge base

The right setup
It is vitally important to ensure that the brightness, 

colour tones and positioning of a second screen are 

set up correctly. You need to consider the height 

of the monitor and to ensure that you are following 

the standard rules to make sure that you are not 

damaging your eyes or your back by using the 

monitors in an unnatural way.

 The settings
macOS will automatically see a 

second screen when it has been 

connected with the correct adaptor. 

Some simple settings will be 

available in Preferences as soon as 

the connection is made.

 Double the fun
When you have a second 

screen connected, you 

will be able to do twice 

as much without having 

to continually jump 

between apps and  

close windows. It is a 

huge time-saver.

 Third-party apps
There are apps available 

that will help you to control 

certain aspects of a second 

monitor’s behaviour so we 

would advise you to try a 

selection of free offerings 

to check which ones work 

best for you.

 Check for drivers
Drivers will likely be available for most monitors, 

but some older screens and those from certain 

manufacturers are still mainly designed for 

Windows computers. Always check for Mac 

compatibility when purchasing a new monitor. 

Some monitors don’t work fully with Macs; they display the 

content perfectly well but are designed for Windows when it 

comes to making finite adjustments to the tones and other 

aspects you would normally be able to customise. Drivers are 

also not always available which means you are left with the 

default setup. There are some solutions available however…

1 Find a driver   
Find the model number of your monitor and  

then go to the manufacturer’s website to see 

if there is a Mac driver available. If it is not, try 

searching the Apple Support Communities for  

an alternative solution.

2 Try an app 
There are apps available that can control a 

second screen when there is no dedicated driver 

for it. Examples include iBright which will let you 

adjust the brightness of the screen to make it 

match your main Mac screen.

Incompatible 
monitors

“Some monitors display the 
content perfectly well on Macs 
but are designed for Windows”
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Speed up Safari with Ghostery

Ghostery is a browser extension which is designed to take 

all of the clutter away from the modern web when used with 

your browser of choice. It has good compatibility with all of the 

popular web browsers, including Safari, and once installed will 

largely work in the background to make your daily computing 

experience quicker and more efficient while at the same time 

protecting your data and potentially saving some space on your 

Mac. It is free, easy to set up and, when used correctly, will be 

a tool that you will not want to live without again. We will show 

you how to set up Ghostery, how to make the right choices and 

will also help you to consider how to use it in a responsible way.

Protect yourself and make your browsing smoother with the free Ghostery solution

Ghostery

Download available

Time needed

10

A simple interface
All the tools you need 

 Knowledge base

Works both ways
While using Ghostery, you may 

see big warnings on some 

websites that stop you using 

the content. The only way 

around this is to whitelist the 

site, but you will need to decide 

if the trackers that are used 

make whitelisting it worthwhile. 

Remember that websites still 

need to make money to generate 

the content you are viewing.   

 Useful settings 
The settings let you decide 

if the options you have 

chosen will be used by 

default and also let you be 

notified of new elements 

when they appear. The 

entire extension is very 

easy to use.

 A safe place  
If you are sure that a 

website is safe, you 

can whitelist it so that 

trackers will be used in the 

future. This makes sense 

for websites that you 

want to support through 

advertising, etc. 

 Visual alerts 
You can view in real time the trackers 

which are blocked by Ghostery. 

Some sites use none at all and others 

use an incredible amount. You get to 

decide what to allow at all times. 

 Tweak every feature  
You can click the Ghostery icon 

and then select exactly which 

trackers to allow in the website 

you are currently viewing. The 

amount of control ensures the 

perfect balance between speed 

and safety. 

Difficulty
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Set up and use GhosteryStep-by-step

Ghostery is continually evolving to help block the trackers and cookies you 
do not want to interact with. The hard work is done for you.

There will be websites that you know well which will benefit 

from whitelisting for a number of reasons. Remember that 

when you block advertising, you are removing the site 

owner’s ability to make money from their work so it is not 

simply a case of blocking with no drawbacks at all. Consider 

whitelisting as many sites as you reasonably can, if you trust 

them and want to support the creators of the content. 

1 Find the option 
Some websites will not display properly because 

they need specific add-ons in order to work. 

Whether this is the case or if you just want to 

whitelist a site, click the Ghostery icon in the 

Safari bar at the top. 

2 Whitelist the site 
Click the ‘Whitelist Site’ icon and a small green 

banner will appear to confirm that it will be 

whitelisted from now on. Simply reload the page 

and the settings will take effect whenever you visit 

it in the future. 

Whitelisting sites

“There will be websites that  
you know well which will  
benefit from whitelisting”

1 Check it out 
Go to ghostery.com and take some time to 

read exactly what the extension does. Please 

make sure that you are happy to be using the 

tool before you install it on your Mac.

2 Install the extension 
When you try to install the extension, you will 

be taken to the official Safari extension site 

which offers reassurance that this is a trusted 

product. Install as normal.

3 The Alert Bubble 
The introduction screens let you enable and 

disable features. We would advise you to 

enable the ‘Alert Bubble’ so that you can check 

what is being blocked on each website. 

4 Think big
When you first use Ghostery, you should 

consider blocking everything. Advertising, 

beacons and privacy are just some of the 

options. You can enable them again later. 

5 Explore the benefits 
Once the setup is complete, you will see the 

Alert Bubble appear on any site that has extra 

code embedded into it. Some of these sites 

use an enormous number of trackers.

6 Make proper checks 
Clicking the Ghostery icon at the top of the 

Safari window lets you see which trackers are 

enabled and which have been blocked. Very 

few sites use no trackers at all. 
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Spring-clean your Mac’s diskStep-by-step

App Cleaner & Uninstaller

1 Sort your apps
Got to the Applications tab at the top and then 

click the ‘Sort’ menu. Select ‘Size: Large to 

Small’ to see which apps take up the most disk 

space. Do you really need them?

2 Delete service files
Select an app to list its associated files. Tick the 

boxes and click ‘Remove Service Files’ to reset 

it so it is like new. Drag the app to the Trash in 

Finder to delete it.

3 View app installers
Have you downloaded apps, installed them and 

then forgotten to delete the installer? They are 

wasting space. Select the Extensions tab and 

then select ‘Installations’ to see.

4 Delete installers
The free App Cleaner will not let you delete 

installers. Point your mouse over the file path 

and click the arrow to open Finder with the app 

selected. Move it to the Trash.

5 View deleted apps
When apps are dragged to the Trash, files 

remain on the disk. Select the ‘Remains’ tab to 

see the apps and their files. Select items in the 

list to view the associated files.

6 Remove service files
Clean up the disk and free up space by clicking 

‘Remove Service Files’. You might need to 

confirm their deletion by entering your admin 

password. Click the ‘Confirm’ button.

Clean your Mac and get more space

App Cleaner & Uninstaller is a great free app in the Mac App 

Store that enables you to recover disk space and clean up the 

system. It can find and remove all the files associated with an 

app, even if it was deleted months ago. Select an installed app 

and it lists every file it created outside of the Applications folder. 

It is then easy to select and delete them using App Cleaner.

If you dragged apps to the Trash to delete them, even a 

long time ago, App Cleaner is able to list all the files that were 

left behind and you can easily select and remove them. Some 

features are limited in free mode, but there are still enough to 

make this a must-have tool. The Pro upgrade is £4.99.

Dragging apps to Trash leaves many files behind – use this free app to find and delete them

Download available

Time needed

10

Difficulty
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On the Extensions tab are Launch Agents and Login Items. These are apps 
and services that start automatically when you log in to your Mac.

Apps and their files
Find the biggest apps and the location of their files

 Knowledge base

What are service files?
App Cleaner & Uninstaller talks 

about service files and it lets you 

search for them, select them and 

delete them, but what are they? 

There are several types and one 

is caches. This is temporary 

file storage used when the 

app is running. Another type is 

preferences, which is where the 

app stores settings. There may 

be other files too.

 Pro features
The padlock indicates a feature 

that is only available in the Pro 

upgrade, such as deleting installed 

applications. There are still many 

useful features in the free version of 

App Cleaner.

 Clear the files
Select an app and 

all its files are listed. 

Tick these boxes to 

delete all the app’s 

associated files. You 

can then manually 

drag the app itself to 

the Trash to delete it 

using Finder.
 Sort options

Click here to open 

the sort options 

menu. Sort the apps 

by size and you can 

instantly see which 

apps take up the most 

disk space. Consider 

deleting them if you 

need more disk space.

 Top tools
Click the ‘A’, ‘E’ 

or ‘R’ tabs to view 

apps, extensions 

and remains. Click 

‘Applications’ to view 

the installed apps and 

select an app in the 

list to view all the files 

wherever they are.

App Cleaner is good to start with but it can be made even 

better by tweaking the settings. Some files belonging to an 

app might be in system folders and you need to configure 

App Cleaner to look for them. You might also want to protect 

system or important apps from being accidentally deleted.

1 Search system folders  
Go to the App Cleaner & Uninstaller menu and 

select ‘Preferences’. On the General tab, tick the 

checkbox ‘Search Service files in the System 

folders’. You will be asked to authorise this, but it 

improves the app’s cleaning functions.

2 Protect your apps 
Select the ‘Skip List’ tab. Any apps added here 

will not be displayed in App Cleaner and are 

therefore protected from being accidentally 

deleted. Click the ‘+’ button at the bottom and 

select the apps you want to protect.

Configure  
App Cleaner

“App Cleaner is good to start 
with but it can be made even 
better by tweaking the settings”



2 Encrypt the disk
Encrypting the disk prevents 

anyone else from accessing its contents 

and makes it extremely secure. Go to 

System Preferences>Security & Privacy, 

click on the FileVault tab and then click 

the ‘Turn on FileVault’ button to start 

encrypting your Mac.

1 Disable file sharing
It can be very useful to be able 

to share files, printers and screens 

and other features over home Wi-Fi. 

However, you should disable them  

when using your MacBook in public 

places like Wi-Fi hotspots. Go to 

System Preferences>Sharing to turn 

them on or off.

3 Safari extensions
There are great extensions for 

Safari, but some dodgy places on the 

internet to download them from. Stick 

with the Apple curated collection of 

Safari extensions for safety by clicking 

on the ‘Safari’ menu bar option and 

choosing ‘Safari Extensions…’.

Firewall options
Configure the Firewall settings in Security & Privacy

 Ultimate security
Tick this box to turn up the Firewall 

security to the max. The Mac blocks 

all connection attempts over the 

network apart from essential ones. 

Some apps may not work.

 Security check
This is a list of all the 

apps that access the 

internet. Check each one 

and make sure that it 

is not spyware, adware 

or malware. Google the 

names of apps you do 

not recognise.

 Hide your Mac
There are ways to detect 

computers and devices 

on the network and 

enabling stealth mode 

prevents them from 

detecting the Mac. This 

is an especially useful 

feature in public places 

like Wi-Fi hotspots.

Top 10 
security tips 
for macOS

Security is a constant worry and your choice of a Mac instead of other 

computers we could mention is certainly a good decision and it helps 

to keep you safe from threats on the internet and elsewhere. However, 

this does not mean that you can ignore security and there are threats 

that can affect your Mac. Phishing attempts, bad email attachments, 

sharing too much at public Wi-Fi hotspots and so on, are all security 

problems that can affect your security.

To make sure you stay safe on your Mac, we have listed our 

ten best security tips. Work through each of of these security tips 

and make sure that your Mac is well protected, especially if it is a 

MacBook that you use with public Wi-Fi.

How to stay safe when using your Mac at 

home or at public Wi-Fi hotspots

 Block access
If you find any apps that you do not 

recognise or that are suspicious, 

click here and set the access to 

Block incoming connections. It 

increases the Mac’s security.
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7 Beware email 
attachments

Malware can be distributed through 

email as an attachment. It mostly 

targets Windows PCs, but it can also 

infect Macs. Do not open or download 

files from emails unless you know they 

are from a trusted source and safe.

4 Fraud warnings
Safari is able to warn you about bad websites before you even 

go there. Click on the ‘Safari’ menu bar option while in the app, then 

choose ‘Preferences’, click on the ‘Security’ tab and tick the box 

marked, ‘Warn when visiting a fraudulent website’.

6 Avoid Java
Java has been reported to have 

been used by malware authors and 

hackers for years. It is rarely needed, 

however, and you should not install 

it unless it is absolutely required. Put 

simply, it’s best if you avoid Java 

completely, meaning your Mac is going 

to be a lot more secure. 

10 Set up a VPN
There are many more ways 

to boost security. For example, you 

might want to consider creating a 

VPN, which encrypts internet activity 

and use passwords that are long and 

complicated (and use a password 

manager to store them).

9 Don’t click links
Email phishing tries to trick you 

into revealing login details for Apple, 

banks, PayPal, Amazon and other 

places. Always treat emails asking 

for login details with suspicion and 

don’t click on any links. If in doubt, go 

through the respective website.

A firewall is a useful tool for keeping out hackers, but it can stop apps from 
working. Lower the security if there are problems.

5 Avoid safe files
Safari can automatically open 

files after downloading them – but 

this is convenient for both you and 

malware. Click on the ‘Safari’ menu bar 

option while in the app, then choose 

‘Preferences’, click on the ‘General’ tab 

and disable the ‘Open “safe” files after 

downloading’ option.

8 Use the Store
The Mac App Store is, without 

question, the safest place to download 

software for your computer because  

the apps featured are thoroughly 

checked. Software outside of the store 

may be brilliant… or it may be malware 

– so beware. 



sensation!
Become a

Y
ouTube is the king of online video but 

there’s a lot more to it than meets the 

eye. The site is designed to let you 

browse countless videos on a variety 

of subjects, letting you marvel at the 

creative content available, and it does tick every 

box in these regards. If, however, you want 

to get more out of your YouTube experience, 

whether that be through creating clips or simply 

enjoying the work of others, read on…

Get more out of your viewing experience and become the next YouTube star

It helps that Apple products are designed for 

creativity and, with iOS and macOS being so 

efficient, you have all the power you need to 

capture interesting moments and to turn them 

into something that could gain you lots of views 

and followers. There is a lot to consider when 

creating video content and we will try to cover 

every area from putting professional movies out 

there to gaining followers and promoting your 

work in an ethical and alluring way.

As with any project, you 

should spend more time than 

feels reasonable planning 

what you want to achieve 

and ensuring you are offering 

a consistent product to your 

viewers. It is all too easy to let 

the excitement overcome you 

and to jump straight in with a 

video created in minutes. This 

would be foolish because 

you have all the tools you 

need to create great things and with some 

patience and careful thinking, the end results 

may even surprise you. When you look back 

on your videos and realise you could never 

have dreamed of making them not so long ago, 

you’ll know that the effort was worthwhile.

Also, try to avoid buying lots of expensive 

equipment. You don’t want to be the golfer 

who spends a fortune on clubs, but who also 

neglects to actually improve their game. You 

can start with an iPhone, a Mac and the  

built-in YouTube editing software and slowly 

work yourself up to better equipment and 

software. There is of course no guarantee of 

success, but even within a service as vast as 

YouTube, talent often has a way of finding an 

audience. All you have to do is create content 

that is interesting, innovative and professionally 

made. It sounds easy, but it certainly isn’t so 

we hope our tips help you get started in the 

wonderful world of YouTube whether you are a 

video producer, a viewer or both.
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ouTube is of course just a website, but 

you’ll find there is a lot you can do to 

enhance your experience when enjoying 

the vast array of content. Many of the tricks are 

very simple and easy to set up, with only a few 

minutes of your time needed to accomplish a 

better end result.

“Looping a YouTube video 
is incredibly easy and 
this simple feature offers 
many advantages”

Loop any YouTube video
Looping a YouTube video is incredibly easy and 

this simple feature offers many advantages that 

you may not have previously thought about. 

To set it up, right-click on the main video panel 

when a video is playing and then click ‘Loop’ 

in the resultant menu that pops up. The video 

will play as normal and will loop over and over 

until you stop it playing. So, why would you 

want to do this? Well, imagine a tropical fish 

scene that you may want to keep playing as a 

virtual screensaver on a large Mac screen and 

you can see how impressive the end result 

can be. You should remember that the video 

Get the most out 
of your viewing 
experience

Stop Auto-Play VideosStep-by-step

 Step 1 A simple command
Quit Safari and open Terminal. Now 

type ‘defaults write com.apple.Safari 

IncludeInternalDebugMenu 1’. Wait a few 

seconds for the next command line.

 Step 2  The Debug menu
Open Safari again and a new Debug menu 

will appear. Look for the ‘Media Flags’ 

option, scroll to it and then click ‘Disallow 

Inline Video’ to stop auto-play videos.

 Step 3  Deal with problems
If you have problems playing YouTube 

videos, as some people report, go to the 

same menu option in the Debug menu and 

untick it. It should work fine, however.

 How to…

will be using power and 

bandwidth, but in certain 

situations, such as dinner 

parties or when you just 

want a relaxing backdrop, 

this solution can add some 

visual ambience. 

YouTube contains virtually unlimited content 

and there are many ways to use what is there 

above and beyond simply sitting down and 

watching videos. You have the option to make 

the videos work for you in any way you like and 

to make the entire experience deeper.
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 Reposition the window
The standalone video can then be 

moved to any corner of your Mac 

screen which will let you carry on 

doing other things while watching it. 

It’s a great way to take advantage of 

the power of your Mac.

 Click the option
In the second menu, you need to 

find and click ‘Enter Picture-In-

Picture’ at which point the video will 

jump from the standard location and 

present itself in a window all on its 

own. It’s a cool hidden feature.

 Bring up the menu
When you right-click on any 

video that is currently active 

in YouTube a small menu will 

appear which is actually not 

the one you need. You need to 

right-click again to bring up a 

second menu.

Run a video picture-in-picture 
Watch YouTube while you work on other apps 

Many YouTube videos are long and can take 

some time to sift through if you are looking 

for specific details within them. This problem 

becomes magnified when you share a clip 

with someone else and have to ask them to 

manually move to a particular time in a clip that 

you are sharing. 

There are ways to add code to the end 

of a YouTube URL which lets you enter the 

minutes and seconds you want to link to. 

A far easier option, however, is to stop the 

video at a specified time and then right-click 

the main video panel. Now select ‘copy video 

URL at current time’ and a link will be ready 

to paste that starts the video at that specific 

point. It works every time, but if you want to 

try something different, you can also go to 

youtubetime.com and enter the minutes and 

seconds there. A URL will then be available to 

copy and share as you need. 

At times it feels as though YouTube is a full 

app within a website because there are so 

many small and useful features that are not 

obvious at first, but which are incredibly handy. 

 How to… Link to a specific time in a YouTube video



AirPlay YouTube videos from  
your Mac to an Apple TV
If you have an Apple TV connected to the same Wi-Fi network as your 

Mac, it is very easy to send a video clip directly to it from your Mac. Look 

for the AirPlay icon in the status bar at the top and click it. You should 

see the ‘Apple TV’ listed and all you then need to do is click the listing. If 

you click the AirPlay icon again, you will be given further options as the 

video plays including ‘Mirror iMac’ where you can in effect use your TV as 

a display for your Mac and ‘Use as Separate Display’ which means that 

you can carry on with what you were doing on the Mac while the video is 

playing on the Apple TV. We are used to sending videos from an iPad or 

iPhone to the Apple TV, but the Mac can also take advantage of AirPlay 

in exactly the same ways if you know how. Potentially, you can enjoy 

YouTube and all of its varied content on almost any Apple device you 

own and you can use them together in clever and seamless ways.

 How to…

Turn YouTube into an app on your MacStep-by-step

 Step 1 Grab the app
Go to the Mac App Store and search 

for ‘DeskApp for YouTube’. Download 

it and install it as normal and then click 

‘Preferences’ from the main menu bar.

 Step 2 Automatic pausing
In the ‘General’ area of Preferences, tick 

the ‘Pause when window is hidden’ and 

‘Resume when window becomes active’ 

options. They are very useful features.

 Step 3 Go dark
You can now click the ‘Appearance’ option 

in Preferences and switch to Dark mode. 

Even the opacity can be tweaked to enjoy 

YouTube in an entirely new way.

“You can enjoy YouTube on 
almost any Apple device you 
own and use them together in 
clever and seamless ways”
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Speed up YouTubeStep-by-step

 Step 1  Check your speed
YouTube naturally uses a lot of bandwidth and so it makes sense to 

check your current connection. Go to speedtest.net and look for a 

connection speed of at least 5Mbps.

 Step 2  Fix disk errors
Open Disk Utility in the Utilities folder, highlight your main disk and 

then click ‘First Aid’. Now follow the process to speed up your video 

streaming in the future.

 Step 3  Add more RAM
When videos are streaming, they are not technically downloaded and this 

is where RAM becomes very important because it is used heavily. The 

more you have installed, the better.

 Step 4  Just one tab
YouTube obviously depends on Safari or any other browser you use 

so try to run videos in just one tab. You may be surprised at what a 

difference it makes.

 Step 5  Lower the quality
If you are really struggling with your internet connection, click the cog 

in the video panel and then ‘Quality’. Now reduce the number to stop 

buffering from occurring.

 Step 6  Try Google Chrome
Safari is designed to work on a Mac, but there is an argument that 

YouTube works best in Google’s Chrome browser. Experiment to see 

which works best for you.



Make your 
videos 
accessible

Check what is popular
It is very important to be aware of what type 

of content is popular on YouTube in order to 

understand what will help your channel to 

grow in the short term. We are not saying 

that you should follow the crowd and we 

fully understand that originality is the key to 

success, but simply knowing what works on 

YouTube can stay in the back of your mind as 

you start to create your content. 

Click ‘Trending’ in the left-hand column to 

see the most popular videos of the moment 

and you can start to gauge what is being 

watched by the most people. You can also 

see what is popular this week and perhaps 

tailor your latest clip to relate to popular 

topics if they are already related in some way. 

You shouldn’t necessarily ‘chase’ viewers at 

all costs, but watching trending videos can 

offer some tips on technique and the kind of 

production that people enjoy. On the flip side, 

if you want to concentrate on a subject that is 

not necessarily too popular, you may want to 

consider producing your clips so that they offer 

an original take on the subject matter.

Build a brandStep-by-step

 Step 1  The Creator Studio
Sign in to YouTube with your Google ID 

and then click the top-right icon followed 

by ‘Creator Studio’. You can now start to 

build your new channel.

 Step 4  Add a description
When you enter and edit the description, 

remember that it is quite important. It will 

help search engines find you and also help 

to create instant viewer engagement.

 Step 2  Your channel name 
Click the top-right icon again followed by 

the cog icon. Next, click ‘Edit on Google’ 

and overtype the name to the one you 

want to use for your channel.

 Step 5  Advanced options 
Click the cog again and then ‘Advanced 

settings’. We advise avoiding adverts 

and AdWords until you have sufficient 

audience to make them worthwhile.

 Step 3  Dealing with visuals
Back in Creator Studio, click on the main 

banner and upload the image of your 

choice. Do the same with the channel 

icon, but make sure they are consistent.

 Step 6  Add your branding  
In Advanced settings, click ‘Branding’ and 

upload a suitable icon to ensure all video 

content is recognised as yours. These 

small changes matter a great deal.

 How to…

W
hen making your own videos, think 

about how you want to present your 

content and put yourself in the shoes 

of your potential viewers. Everything from the 

title of each video clip to the type of thumbnails 

you use to present the videos matters.
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 Tweak the picture

As with photos, spend some time 

playing with the colour temperature, 

contrast and saturation options. With 

some patience, they can make a 

fairly dull clip feel much more inviting 

and you can use similar options over 

every video for consistency.

 Keep it simple

Try not to go mad with slow motion and time-

lapse features. They look great and can add some 

entertainment value, but ultimately most people 

want to see videos play at normal speed and to 

enjoy a consistent experience.

 Using filters

If you select a filter, 

it will be previewed 

immediately and 

you can see how it 

compares to the original 

clip as well. The right 

filter can make any clip 

feel a lot more inviting 

than the competition.

Add some personality
Most YouTube videos are presented in a similar way – using the 
best recording techniques possible. You can, however, go for a 
subtler tone and make some quick adjustments
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“Play with the colour 
temperature, contrast 
and saturation options”



Take a long time to think about 

the title of each video you upload. 

The very first thing that will draw 

viewers in is an interesting title 

and all you need is for people 

to press play and the rest will 

be down to the quality of your 

production and the interest of the 

subject. Think about the titles of 

the videos you enjoy and why you 

clicked on them in the first place. 

Some carefully considered words 

can make all of the difference to 

your success. Once you have 

the title, you need to come up 

with an interesting description 

which should not be too long and 

rambling, but which should get to 

the point and again make people 

want to press play. We would 

advise also that you use as many 

tags as you can, but do make 

sure that they relate to the actual 

video content, otherwise you 

may find you put people off future 

videos that you publish. 

Access the ‘Cards’ feature by 

going to the video editor and 

clicking the ‘Cards’ tab above 

the video preview panel. Click 

‘Add Card’ and select ‘Video 

or Playlist’. Here you can select 

one of your other video clips and 

the viewer can simply click it to 

start watching it straightaway. 

This offers an immediate portal 

into your other work, but when 

used carefully it will not distract 

from the content they are already 

watching. Our advice is to use the 

small timeline below the video clip 

and to place it near the end. The 

goal here is to keep the viewer 

watching your content and to 

stop them from clicking a clip and 

then moving elsewhere after they 

have finished watching it, and as 

such the cards work very well to 

add some extra stickiness to your 

YouTube channel. Don’t overdo 

cards because they have the 

potential to be annoying.

Get the right title

Use cards

Make your videos the right length

Build a community

Ideally, you need to produce clips 

that are of manageable length for 

the viewer to quickly understand 

what the subject matter is and to 

make them truly accessible. The 

best way to do this is to make a 

short clip in the first place and to 

ensure that there are no dull or 

quiet bits, but if you need to trim 

your clip there is an easy way 

to do that on the YouTube site 

itself. Go to youtube.com/editor 

and drag the thumbnail for the 

clip you want to trim down to the 

timeline bar at the bottom. Now 

click the small scissors icon and 

let the video play. When you stop 

the playback, you will be asked if 

you want to ‘Split clip here’. When 

you select it, a new thumbnail 

appears and you now have a new 

shorter clip to play with. There are 

much better ways to deal with clip 

lengths, which we will cover, but 

for quick management of video 

lengths this is an efficient option. 

YouTube comments have a 

reputation that is not always 

positive and so it is hard to offer 

definitive advice as to whether 

you allow people to comment on 

your work or not. We would say 

give it a try when you first start 

and monitor the situation closely. 

The likes and dislikes are a 

standard part of YouTube and you 

should use these as an indicator 

of what people think of the quality 

and content of your clips, but 

comments can also do the same 

job. Constructive feedback is 

always useful and in YouTube this 

is the fastest way to read it. It also 

makes the viewer feel invested 

and that you are open to their 

thoughts. Despite YouTube being 

primarily a video site, it is amazing 

how many people read the 

comments and check the ratings 

and viewing figures. The more you 

can offer people to read when 

your video is live, the better.

 How to…

 How to…

 How to…

 How to…
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Build your content
Patience is key when building an online 

presence. Hone your craft and keep your 

videos private until you are ready. Create a 

selection of videos that can be published at 

the same time so you will have a body of work 

ready. This means viewers are far more likely to 

watch more than one video and to understand 

what your videos offer 

and they are therefore 

more likely to subscribe 

to your channel. A 

YouTube channel is 

about much more than 

presenting a few clips 

for people to watch 

– it is about building 

momentum and gaining 

an audience which 

means that content is 

key. The patience you 

use in the early days 

will also let you try out 

different techniques 

and understand what 

works visually and  

what doesn’t. 

A
s with all aspects of online publishing, 

increasing your reach is crucial to getting 

eyes on your work. There are thousands, 

probably millions, of people producing 

wonderful work online who have only a handful 

of followers which seems a real shame to us. 

It may not always feel like the comfortable or 

proper way to work, but if you follow a few bits 

of advice, the end result will be many more 

viewers than you would have otherwise.

Increase your reach
 How to…

 How to…

Use social networksStep-by-step

 Step 1 The popular networks
Try to create a new Twitter account with 

the same name as your channel and make 

sure you use the same image for your 

banner. You are building a brand here.

 Step 2  Cover all bases
Facebook and various other networks 

should also be used to increase your 

reach as wide as possible. Three or four 

networks should be more than enough.

 Step 3  Automated promotion
In YouTube ‘Account Settings’ make sure 

that you connect your new accounts so 

that you can promote each video over 

them as soon as they are uploaded.

Create a network
Not everything you need to do when publishing 

videos to YouTube is of a technical nature – 

the ability to connect with people is also very 

important for gaining viewers. This also applies 

to the relationships you build in the early stages 

and so we would advise that you comment 

on channel videos that cover similar subjects 

to yours and try to make contact with the 

publishers direct. If you have a body of work 

ready to go, you can ask for their advice and 

potentially they will link to your clips or mention 

them to their subscribers. If you find a channel 

you feel is a good fit, click ‘About’ and you 

should see more information about the person 

running the channel. You can send them a 

message over YouTube or sometimes view their 

email if you are looking at a more professional 

pitch. Even if this information is not obviously 

available, there are ways to find contact details, 

but do be considered in your approach.



Optimise each clip
The information held within each clip can 

be very useful to YouTube and will help to 

automate some of the keyword attribution that 

is required to gain lots of views. When you are 

creating your clip, make sure that you give the 

file an appropriate name that makes it obvious 

Create a blog
Your YouTube 

promotion has to be 

spread out to garner 

a decent number of 

viewers because you 

cannot reasonably 

expect to gain popularity within the confines 

of YouTube alone. With millions of users and 

creators using the service, it is a crowded place 

to succeed within and so we would advise you 

to look at related online services that will help 

grow your viewership. You can create a blog 

very cheaply and even for free so a little extra 

work in the initial stages could be worthwhile. 

Anything you can do to point people to your 

channel is beneficial and even if you decide to 

drop the blog once your YouTube subscribers 

have reached a level you are happy with, you 

will have at least offered another way to get 

your work noticed. You will need to be careful 

not to try too many avenues that take away 

time from the art of video creation, but a simple 

blog and some social networking will offer more 

potential without dominating your time. 

 Type in a keyword
Scroll down to the ‘Keywords’ 

section and input a word that you 

are considering including in your 

video description or as a tag. Type it 

in to check its current popularity.

 Check the popularity
The results are displayed alongside 

other keywords so that you can 

decide exactly what to include. Some 

careful planning of what you input 

could greatly increase your reach.

 Go to AdWords
Go to adwords.google.com and 

sign in with your Google ID. You 

will have to navigate through 

a couple of screens, but you 

will then be presented with an 

option to build a new campaign.

Keyword 
popularity
Find out which keywords 
will be the most effective  
to include. Here’s how…

Understanding keyword popularity 

can be crucial if your ambitions are 

great and you want to aim for the 

big time. There is a simple trick to 

check what is popular and with the 

help of Google you will soon know 

which keywords you really should 

be including in your video clip tags. 

 How to…  How to…

to any human or machine what it is about.  

Also, you should be able to add a description 

if you right-click the file in Finder and click 

‘Get Info’. Click the ‘Comments’ section and 

you will be able to add all of the keywords 

and information that is useful to get your clip 

noticed by a wider audience. These simple 

additions highlight 

the mindset required 

to be a successful 

YouTuber – you need 

to cover every single 

base and think hard 

about what you are 

doing every single 

step of the way. 

There are millions of 

amateurish videos 

on YouTube, but the 

ones which truly stand 

out are those where it 

is obvious that much 

care and attention  

has been paid to the 

end product. 
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P
aramount to everything you do when 

creating YouTube content is maintaining 

high-quality throughout your work. We 

cannot stress enough that for the long term 

you need to be creating work that will stand the 

test of time and which will grow organically as 

people begin to appreciate your efforts. 

In an environment as big as YouTube, you 

simply cannot expect to gain thousands of 

subscribers overnight. We have to rely on 

hard work, patience and lots of care to create 

moving moments that people will share and 

discuss with others. It may be that it takes 

many months for your subscriber numbers to 

Create high-quality content

Write a script
Scripts are important if you 

are creating an instructional 

video or reviewing a product. 

The trick is to work on bullet points and to not 

sound as though you are reading every word 

in the same way you would give a presentation 

at work. There is nothing to stop you from 

recording the video first and adding your voice 

afterwards which can help you to get things 

right, but then again there is little to match a 

flowing video clip that works with the visuals 

and audio running naturally together. Write 

some bullet points about the areas you want 

to cover and then only refer to them as you are 

speaking naturally while capturing the video for 

the best results. There is no need to practise in 

the traditional sense of the word, but you will be 

surprised at how familiarity and repetition can 

help you become a more natural speaker. 

 Step 1  
Find the settings
Many of the settings 

in iOS are hidden, but 

finding them can offer 

many benefits. Go to 

Settings>Photos & 

Camera and then scroll 

down to ‘Record Video’. 

 Step 2  
Choosing  
your setup
The current setting will 

be displayed with 4K 

likely not being selected 

by default. Tap the 

setting to see which 

options are available.

 Step 3  
4K vs memory
4K video capture will 

use 350MB of memory 

per minute, but you 

can delete the clip after 

publishing and the video 

quality will satisfy every 

single viewer.

grow, even years, but hang on to the fact they 

are growing and think about the end game. Set 

realistic targets that fit with the popularity of the 

topics you are creating videos for and then let 

your work do everything else. 

It may surprise you to learn that you don’t 

need to spend a fortune on equipment to 

build high-quality videos and that the kit 

you already own will likely be good enough. 

Offering something unique with a huge dollop 

of personality will work very well. When you 

find your voice and your visual style, stick to it 

and develop it over time. Be patient and work 

hard to create the best quality videos you can. 

With a little bit of luck, 

the tips we are offering 

here may help you 

stand out in a sea of 

YouTube wannabes 

who one day may 

want to emulate  

your success.

 How to…

The latest 

iPhones can 

capture 4K video  

and in tests it 

has been shown 

that 4K capture 

on an iPhone 

is more than 

good enough for 

most publishing 

purposes. So 

start off with 

your iPhone and 

then move up 

to a dedicated 

camera solution 

later. Enabling 

4K video capture 

is very easy and 

only takes a few 

seconds. Here’s 

how to do it…

An iPhone is good enoughStep-by-step
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Blur without editing
There are some very clever features available 

in YouTube itself and one of them is called 

Custom Blurring. It lets you select any part 

of the video clip you are publishing at which 

point the contents will be blurred. This is very 

useful if you have spent a long time creating a 

complex video and then realise that an object 

or person should not be recognisable. Number 

plates could fall into this category and we 

would advise playing it safe when it comes to 

removing things that could potentially get you 

into trouble. Even better, the feature blurs parts 

of the video in such a way that it looks highly 

professional and does not distract from the 

rest of the content that is on display. As with 

all editing features, only use custom blurring 

when you need to and try not to overdo its 

use on every video that you create. Finding the 

right balance is key to making your YouTube 

videos look as though they have been carefully 

crafted every step of the way. You can also 

automatically blur all faces which will save you a 

lot of time in the creation process.

Improve the audio
One area that is often missed when creating 

videos is the audio quality, but it is incredibly 

important. A wonderfully produced visual 

experience can be let down hugely by poor 

or muffled audio and an average quality clip 

can be greatly enhanced by good audio. The 

idea here is to produce audio that matches 

the quality of your video production and if you 

are aiming for great visuals, you will need to 

consider a professional microphone to produce 

great audio. As good as the iPhone 7 and many 

high-end cameras are at capturing motion, they 

often need a little help in the audio department. 

If you are creating videos indoors or in a static 

location, a microphone such as the Blue Yeti 

will add warmth and depth to your spoken 

words and, despite a small learning curve in 

understanding how to get the best results, your 

video clips will be noticeably improved with this 

one accessory. You will also be able to use a 

professional microphone for any other projects 

you are considering such as podcasts. A great 

video needs great sound to be a success.

Final Cut Pro X
£299.99/$299.99
Final Cut Pro is ‘the’ 

recommended solution for 

anyone who wants to edit 

videos on their Mac. The 

included features are vast  

and quite brilliant.

Motion
£48.99/$49.99
If you want to add professional 

effects without breaking the 

bank, Motion from Apple is a 

decent mid-range solution to 

practise your craft with.

Compressor
£48.99/$49.99
Video conversions just became 

easy with the Compressor 

app. It’s an official Apple 

product and works seamlessly 

with Final Cut Pro to produce 

stunning results.

Adobe Premiere Pro
£20.22 per month/  
$19.99 per month
The monthly charge covers a 

range of image and video apps 

and when you learn how to use 

these apps, your results will 

truly shine.

ZetGIF – Video  
to GIF Simple 
Universal Converter
£2.99/$2.99
Trim one of your videos, 

convert it to a GIF using this 

app and you have a ready-

made preview to promote  

your work in style.

 How to…

 How to…
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“The audio quality is 
incredibly important – 
you need to consider a 
professional microphone”

THE BEST MAC 
VIDEO EDITING APPS
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Download available

Time needed

30

Difficulty

Create personalised 
videos with Clips

When it comes to the world of video editing apps, there are a lot of 

options out there. Some will focus on helping you create the next 

AAA blockbuster, while others are tailored for those wanting to add 

a bit of flair to their own video library. Apple’s latest first-party app 

is Clips, a video editing app that blends together advanced and 

basic video edits into one complete package. At its core is a range 

of tools, all of which change different elements of your chosen 

video. Elements such as adding text overlays, playing with colour 

levels and blending together files are all possible within Clips. 

Here’s everything you need to know about the app.

Apple’s all-new Clips app is the perfect way to 

transform your existing videos into something new

Clips

Personalise your video clipsStep-by-step

1 Choose your file
Open the Clips app and navigate to the bottom 

of the app where you’ll find the import options. 

Use the Library option to select and import a 

recording into Clips.

2 Create your own
Alternatively, record your own video by 

selecting the video option, and then using the 

red bar to control your recording. Stop the 

recording and the video will import.

3 Add an introduction
Select the ‘T’ icon at the top of the Clips 

app. This will open up a series of introduction 

panels, and by pressing on one, you can add 

one of them to your existing video.
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Master Clips’ 
editing options
Transform your video with simple 
editing techniques

 Implement text
The option on the left of the toolbar will allow you 

to add small amounts of text to your video. You can 

also use the title option to add an introduction.

 Create from scratch 
Users can choose if they want to record a video, 

or take a photo from scratch to use in Clips. 

Alternatively, use the library option to import an 

existing video from your library.

 Integrate Apple Music 
Select the note icon on the top right to integrate 

your favourite Apple Music track on top of your 

video. Once imported, you can control the volume 

levels that it plays at.

Want to record a selfie? No worries. Use the front-facing camera option 
when recording a video to get your face into Clips’ editing suite.

 Knowledge base

Importing multiple clips
Although Clips works better on 

individual video files, when importing, 

users can choose to add multiple videos 

at the same time. This means, that any 

edit you add will be placed over all of 

your clips, which saves you the hassle of 

having to repeat each edit you make.

4 Overlay some text
Now choose the text icon from the top toolbar. 

Different styles of font and text overlays will 

appear. Press on one, and then use the box 

provided to add your own text.

5 Implement a song 
The final edit is to integrate a song that plays 

over your video. Choose the music icon, 

followed by the ‘My Music’ option to open your 

Apple Music library and all of your tracks.

6 Share with friends
Once done, press on the arrow option at the 

top left of the app. From here, use the Share 

option and choose how you want to share your 

video with friends and family.

 Customise with filters
Use the familiar filter option to add 

a coloured overlay to your video. 

When a filter is applied, use the slider 

provided to change the overall colour 

levels that will then be shown.
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1 Allow data uploads
After setting up your account, 

you’ll be prompted to select if you 

want to allow for cellular uploads. 

While helpful, it can use a lot of 

your data allowance if you’re on a 

tight contract.

2 Initial backup
Shoebox will now begin to perform 

an initial backup of your entire 

photo library. You can track its 

progress using the ‘Remaining’ 

tab which is shown towards the 

bottom of the app. 

3 Check your backup 
Once done, select the ‘Me’ option 

from the toolbar and then the 

‘Backed Up Photos’ tab. Have 

a look through and make sure 

that all of your photos have been 

correctly backed up. 

4 Explore  
your account
Select the ‘Timeline’ option and 

scroll through your backed up 

photos. Use the Month and 

Year options provided to switch 

between different account views.

Automate photo 
backups with Shoebox

One of the best things about owning an iOS device, is having 

access to a fantastic rear-based camera. However, too many 

photos can soon lead to you running out of enough internal 

storage for other things. Backing up your photos to an online 

cloud account may not be difficult, but being able to automate 

the process is something entirely different.

One of the benefits of the Shoebox app is that users are able 

to automate any and all images they take on their iOS device. 

Not only does the app detect and upload any images you take, 

it even works with images that you upload to your Facebook 

account. Shoebox is a near-essential app for all photo buffs to 

enjoy, so here’s how to master its basics.

Take the stress out of managing your photo library 

with the impressive Shoebox app

Shoebox

Backup your photos with ShoeboxStep-by-step

Download available

Time needed

45

Difficulty
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5 Share your photos
Long press on any photo and use 

the ‘Share’ option if you want to 

distribute your photos. As well as 

sending them to friends, you can 

also add them to your own virtual 

Shoebox album. 

6 Cloud print
If you want to print, load a photo 

and press the three-dot symbol 

at the top left of the app. Use the 

menu that now shows to select 

‘Print’, and then search for your 

wireless printer. 

7 Get more details 
Alternatively, you can bypass the 

print option and select ‘Details’. 

This will give you an overview of 

where the image was taken, as 

well as the camera details of  

your device. 

8 Integrate  
with Facebook 
Back on the homepage select ‘Me’ 

and then the ‘Backup Settings’. 

From here, enable the ‘Facebook 

Photos’ option and integrate your 

Facebook library of images.

Once you’ve backed up your images to Shoebox, make sure you delete 
them from the Photos app to free up some internal storage.

1 Piccam
Piccam arguably offers the best 

management tools out of the apps 

featured here. Photos can be split 

between different events, locations and 

even keywords.

2 Google Photos
Not only can you upload your image into 

the Google Photos app, but you can 

also perform some impressive edits to 

anything and everything in your account.

3 iCloud
How could we ever forget iCloud? The 

best reason for using iCloud is that it 

brings together your entire photo library 

across your iPhone, iPad and even your 

Apple Watch.

Best apps for online photo management
1 2 3

“Piccam arguably 
offers the best 
management tools”
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1 Flip the case lid  
The first method is simple: just flip open the lid 

of the AirPods’ charging case with the buds 

inside and the battery charge for both devices 

is displayed on your iPhone.

2 Use the Batteries widget 
Alternatively, use the Batteries widget. Swipe 

right from the home screen of your iPhone, 

scroll to the bottom of the screen and tap 

‘Edit’. Select the ‘+’ icon next to Batteries.

3 View the charge status 
Now when you swipe right from the home 

screen, you will see your AirPods charge within 

the Batteries widget. You’ll see the case too if 

one or both AirPods are inside it.

Check your AirPod 
battery status

Your AirPod batteries give five hours of listening time and two 

hours of talk time on a single charge. Boost their life by keeping 

them in the case when they’re not in use and limiting the 

number of times you open and close the charger lid. You can 

also hold the setup button on the case for 15 seconds until the 

light flashes amber then white if you find they drain too quickly. 

But how do you tell when the juice is running out? There are 

three options: listen for the low charge tone in the AirPods; for 

Macs, open the case lid or remove the buds, click the Bluetooth 

menu and hover over AirPods; and for iPhones, see below.

Use your iPhone or Mac to see how much juice your AirPods have left 

Settings

Monitor an AirPod’s charge statusStep-by-step

Download available

Time needed

2

Difficulty
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Use Apple TV’s new iPad remote app

With the 1.1 version of Apple TV comes iPad support at long 

last and, like its iPhone counterpart which has been around for 

a while, it allows you to use the tablet to control your viewing. 

It’s easy to set up and uses the same selection of buttons as 

the tiny Remote. There are a few extra tricks up its sleeve such 

as the ability to play games more comfortably, Siri support 

and simple methods of shuffling and replaying audio. Tapping 

‘Details’ when playing a video allows you to see chapters, 

audio tracks and captions and you can also view audio playlists 

and lyrics. You must have iOS 10.3 or later for these, however. 

The same functionality exists for the iPhone version too.

Apple has finally brought the many delights of the Apple TV Remote to the iPad

Apple TV Remote

Download available

Time needed

5

Get to grips with the Apple TV app
Familiarise yourself with the basic buttons and functions

 Knowledge base

See recently used apps
If you want to see the apps 

that you’ve recently used, then 

double-tap the TV monitor 

button within the iPad Apple 

TV Remote app. You can then 

swipe left and right in the Touch 

surface area and tap the screen 

to open an app. Tapping this 

icon once also takes you back to 

the main home screen.

 Now Playing window 
When you’re viewing content 

on Apple TV, tap ‘Details’. The 

Now Playing screen will display 

the running time, give playlist 

information and lyrics for audio 

and show information as well as 

associated chapters for video.

 See your Devices  
If you have more than one 

Apple TV, then by tapping 

‘Devices’ you can select 

which one you want to use 

via this drop-down list. Tap 

‘Edit’ if you want to delete 

Apple TVs from the list. 

 Playback buttons 
Tapping ‘Menu’ takes you to 

the previous screen or menu 

while tapping the play/pause 

buttons lets you start and 

stop the action. Fast-forward 

and rewind buttons appear 

during playback of visual and 

audio content.

 Improved  
swipe controls 
As well as swiping on the 

Touch surface and tapping 

to select menu items, you 

can use the slider in the Now 

Playing window to move to 

a specific section of your 

content. Video has a blue 

audio icon for captions.

Difficulty
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Set up the Apple TV appStep-by-step

To change your Apple TV’s volume using the iPad remote (via the physical 
volume buttons on your device), you need receivers that support HDMI-CEC.

1 Add your Apple TV 
Download the new iPad Apple TV Remote 

app from the App Store and open it. You will 

immediately be requested to add your Apple TV 

so simply tap the button on the iPad screen.

4 Using Apple TV 
The interface mimics what you’ll find on the 

Apple TV Remote with controls at the bottom 

of the screen and a touch area. A mic icon 

appears if you use a fourth-gen Apple TV.

2 Choose the TV 
Your Apple TV will show on the next page as 

long as it is on the same network as your iPad. 

If you have more than one, each will display. 

Tap the one you want to connect with.

5 Inputting text
If you come across an Apple TV screen which 

requires you to input text, a keyboard will 

automatically appear on the iPad remote. You 

can also use Siri by pressing the mic.

3 Enter the code 
A code will appear on your Apple TV screen. 

You will need to enter this code in the boxes on 

the iPad in order to pair the two devices. You’ll 

be ready to go within seconds.

6 Playing a game 
When playing a game on 

Apple TV, you should see 

a joypad icon at the top of 

the iPad app’s screen. Tap 

it to activate an onscreen 

controller and turn the iPad 

landscape to use.
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Download available

Time needed

5

Difficulty

When to delete 
outdated apps

You may have dozens of apps which have been abandoned 

by the developer or left without an update for a good while. 

Last year, Apple told developers that it was going to axe such 

programs from the App Store, and it appears the tech giant is 

going to kill support for 32-bit apps too, so future iOS updates 

could cause many of the apps on your device to stop working. 

Warning boxes are already appearing on your screen when 

you open old apps, telling you they need to be updated. But 

how can you find out which apps are about to die and need 

deleting? The answer lies within the Settings app and a new 

tab called App Compatibility. 

Apple will stop supporting a host of 32-bit apps in iOS 

11. Find out which of your apps will be affected

See a list of abandoned appsStep-by-step

1 Go to Settings
As long as you have iOS 10.3 installed on your 

iDevice, you are able to see which apps have 

not been updated for a long time. Open the 

Settings app and navigate to ‘General’.

2 Navigate the options
Now tap ‘About’ to call up a page of 

information about your iDevice. Be patient as 

it loads all the details (it won’t take long), then 

look for the option marked ‘Applications’.

3 Find the apps
Next to ‘Applications’ will be a number showing 

how many apps you have on your device. Once 

a ‘>’ icon appears, you can tap it to see some 

of the apps you have installed.

Settings
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Keep 
or delete?
Work out which apps should stay 
and which should definitely go

 Check the last updates
If we click on Tickety Split, we will see that it was 

last updated in 2014. It appears to have been 

abandoned – we note it doesn’t even use the full 

height of the screen. One to bin.

 Update your apps
Apps here will have updates available, making them 

compatible with future iOS updates. So if you like 

and use the apps that are listed here, keep them.

 Remove unsupported apps
Some apps, such as Magzene for 

instance, are not currently available in the 

App Store. They are unlikely to reappear 

in the future so consider deleting.

 Look for alternatives 
The Firefox Home app gave you access to your 

Firefox desktop history, bookmarks and open tabs. 

It’s unavailable on the App Store now so is one to 

delete and replace. Get Firefox for iOS instead.

If you’ve paid for an app and it stops working, there is unfortunately no way 
of getting a refund if you’re outside of Apple’s 90-day help period.

 Knowledge base

How to delete an app
If you discover that an app is likely to cause you 

trouble in the future or it has been abandoned and 

removed from the App Store, consider deleting it 

and looking for an alternative. To remove it, find the 

app icon on your home screen and press and hold 

it. It will start to wiggle and display an ‘x’ in the 

corner. Tap this and confirm deletion.

4 View the list
The list displays apps which may slow your 

iDevice and cause future problems. Apps 

where updates are available appear at the top, 

above those with no available updates.

5 Checking the apps 
Go down the list and tap each app. If a box 

tells you the app is unavailable in the App Store, 

it’ll have been abandoned by its developer and 

may not work when iOS next updates.

6 Contact the developer
Some apps will still be available but you’ll have 

to write to their developers to see if they will be 

updated. Look for their contact details on the 

app’s App Store page.
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Download available

Time needed

5

Difficulty

Find your AirPods 
using your iPhone

Apple’s AirPods are great for listening to music and chatting 

hands-free but their small size means there is every chance that 

you will misplace them from time to time. With a replacement 

of a single bud from Apple costing £65/$69, you could be 

seriously out of pocket. Thankfully, help is at hand. As of iOS 

10.3, Apple has made it much easier to find missing AirPods. 

It has integrated a Find My Airpods function within the Find My 

iPhone app, so you don’t have to aimlessly rip your house apart 

to find they’re stuck down the back of the sofa. A chirpy sound 

will lead the way for a couple of minutes instead.

The latest version of iOS now lets you quickly 

search for your missing in-ear buds

Find My iPhone

Track down your missing budsStep-by-step

1 Open the app 
To track your AirPods, you need to use the Find 

My iPhone app. Open it and wait while it looks 

for your devices. If the AirPods are in Bluetooth 

range, it will locate them.

2 Select the buds
If your AirPods are top of the list, their location 

will show immediately. Otherwise select them 

from the list at the bottom of the screen. They 

will be pinpointed on the map.

3 Tap for Actions
After selecting them, you will see an option at 

the foot of the screen labelled ‘Actions’. Tap 

this in order to call up a couple of options to aid 

you in locating the AirPods.
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Use iCloud to track 
your AirPods too
Don’t have your phone to hand? Then 
log in to iCloud.com in any browser

 Colour-coding
Each entry in the list will have a different 

coloured dot. Blue indicates the current 

device being used to track the AirPods 

while green indicates they are online and 

able to play a sound.

 See your Devices  
When you’re logged 

into iCloud.com, select 

Find iPhone and click 

‘All Devices’. Then click 

AirPods to see their 

whereabouts on the map.

 Out of range
A grey dot means your AirPods 

cannot be tracked. They may be off, 

in their case or out of battery. When 

the AirPods are disconnected from 

your iPhone, Find My iPhone will only 

show the time and location when 

they were last connected.

If you have one of the AirPods, it’s best to avoid confusing Find My iPhone 
by placing it in the case, preventing its location from being picked up.

 Knowledge base

Lost your  
AirPods case?
Unfortunately, you are only able 

to locate your AirPods when they 

are outside of the case. So if you 

have them safely tucked away 

and you lose them, then you’re 

sadly out of luck – Find My 

iPhone won’t be able to make 

them play a noise and you’ll 

have to search the old-fashioned 

way. There’s also no way of 

locating a lost, empty case.

4 Play a sound
One option is to force the buds to make a noise 

by tapping ‘Play Sound’. The AirPods will emit 

a beeping sound which will increase in volume 

the longer it takes to find them.

5 Mute an AirPod
If you’ve only lost one of the AirPods, you can 

opt to mute the sound coming from the one 

you have. Just tap ‘Mute Left’ or ‘Mute Right’ 

and the noise from one will be cancelled.

6 Locating further away
But what if there’s no connection between the 

buds and the iPhone? Find My iPhone will look 

for the AirPods’ last known location. Tapping 

the car icon directs you to them.

 Play the sound
Just like on the iPhone, 

you’re able to get the 

AirPods to make a 

chirping sound. Simply 

hit this button and 

follow the noise.
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1 Secret Conversations  
Open Facebook Messenger and tap your profile 

image. Select ‘Secret Conversations’ and turn it 

on using the slider on the next screen. Confirm, 

tap ‘Me’ to go back and tap ‘Done’.

2 Chat in secret
When you want to message someone using 

end-to-end encryption, go to Facebook 

Messenger’s home screen and tap the ‘+’ icon 

(top right). Now tap ‘Secret’ and select a friend.

3 Write and send
You can write a message or send images and 

emojis. Messages disappear after ten seconds 

but tap the clock icon to change the timer, 

turning it off or making it as long as a day.

Have an ultra-secret 
chat in Facebook

We expect our messages to be private and secure, however they 

can be intercepted as they wing their way from your device to a 

server. The only way to ensure just you and the intended recipient 

can read a message is to use end-to-end encryption. This 

scrambles and locks a message from the moment it leaves your 

device until it lands on the other person’s. The message can then 

only be unlocked using a private key and it is so effective, even 

the messaging service cannot read the content. But while some 

services such as WhatsApp use end-to-end encryption by default, 

others such as Facebook Messenger need it turning on…

Ensure your conversations are private by enabling 

end-to-end encryption on your iOS device

Facebook Messenger

Start a secret conversation in MessengerStep-by-step

Download available

Time needed

5

Difficulty
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Download available

Time needed

5

Difficulty

What is new in 
watchOS 3.2?

The evolution of the Apple Watch and watchOS has been 

carefully managed by Apple and there are good reasons for 

this. With a device the size of a watch, it would be extremely 

easy to overcrowd the screen and to make things too complex 

so Apple has decided to only add new features that are truly 

useful. Also, limited battery size and processing power means 

that the experience is defined by how easy everything is to use 

and, with this in mind, practicality is high up the list. 

The latest system update, watchOS 3.2, fits in perfectly with 

this mindset and will give you subtle new features that you 

will use time and time again. The best features are those that 

become invisible and this is true of Theater Mode, SiriKit and 

the small colour changes in the latest version of watchOS. 

Read on to learn more about all of the new watchOS 3.2 

features and when they can prove useful. 

Once again, Apple has concentrated on offering only 

features that will prove to be truly beneficial

Apple Watch

Make the most of watchOS 3.2Step-by-step

1 Find Theater Mode 
Swipe up from the bottom of your Apple Watch 

screen and you will see a new layout after you 

have installed watchOS 3.2. In the bottom 

right-hand corner will be a new icon. 

2 Enable Theater Mode 
Tap the new icon and it will turn orange. Once 

it is enabled, when you lift up your wrist the 

screen will remain dark and silent mode will be 

automatically turned on. 

3 New colours 
A selection of new Apple Watch straps has 

been released and so Apple has made some 

tweaks to the colours available within the watch 

faces. The colours are very subtle. 
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What is new?

Theater Mode means that you can sleep with your watch on and never be 
disturbed by the screen. There are multiple uses for this feature.

Familiarity reigns supreme 

 Elegant style changes 
The new colours that can be added 

to each watch face work well to 

match a selection of new watch 

straps which Apple has released. 

Truly elegant style has arrived.

 Future focus
When app developers take advantage 

of SiriKit on the Apple Watch, you 

will be able to book rides and do so 

much more without needing to pick 

up your iPhone. 

 A simple indicator 
When Theater Mode is enabled, a 

small icon will be the only indicator 

that it is currently running. It’s an 

incredibly useful feature that works in 

many different situations. 

 A tiny change
The only obvious visual change in 

watchOS 3.2 is the rearrangement 

of the control panel. Every other part 

of the main operating system looks 

identical to before. 

 Knowledge base

It’s evolutionary
The changes in watchOS 3.2 are 

deliberately restrained, but they 

are significant in that you will use 

them every single day. Just like 

Night Shift and Do Not Disturb 

in iOS, once you have them set 

up they start to feel invisible, but 

they will offer huge advantages 

over and over again. There are 

nothing but positive features in 

the new watchOS.  

4 A consistent style
The new colours mean that you can choose 

one of the new straps and match the watch 

face so that the theme throughout is consistent. 

These small touches add a lot of style. 

5 SiriKit on board 
The addition of SiriKit in watchOS means that 

app developers can now let you do things that 

were not previously possible on your Apple 

Watch. These will appear in time. 

6 SiriKit advantages 
You will be able to send payments, book 

rides, start workouts on third-party apps and 

potentially do a lot more without even needing 

to touch your iPhone. So convenient. 
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Force quit apps  
on Apple Watch

Although you may expect all of your Apple Watch apps to 

run like clockwork, unfortunately this isn’t always the case. 

Sometimes the rotating dial spins for what seems like forever or 

bugs cause an app to behave in a peculiar manner. Apps can 

also freeze, preventing you from doing anything else with your 

wearable. Yet if any of these things happen to you, don’t fear. 

Help is at hand with a couple of button presses.

Just as you can force-quit an app on your Mac, iPhone or 

iPad, you can do the same on your Apple Watch, even if it 

does feel a little trickier to pull off the first time you try it (more 

so since, prior to watchOS 3, it was a simple case of double-

clicking the side button). This should allow you to restart the 

app without any issue but if the problem does persist you may 

need to consider deleting and reinstalling the app or even 

resetting the Watch. But hopefully it won’t come to that.

Discover how to quickly shut down unresponsive 

apps which cause your Apple Watch to freeze

Force close a frozen appStep-by-step

Download available

Time needed

2

Difficulty

1 Take action
When an app freezes or otherwise behaves 

as it shouldn’t, press and hold the side button 

for a few seconds. This will allow you to regain 

control over your Apple Watch.

2 Don’t power down 
You will be taken to the Power Off screen but 

don’t tap anything on the display. Instead, 

press the Digital Crown and hold it down for a 

few seconds before letting go.

3 Restart the app 
The app will force quit and the Watch will take 

you back to the homescreen of apps. You can 

restart the app if you wish or get on with doing 

something else with your Watch.

Apple Watch



FOR THE GNU GENERATION

Available from all good newsagents & supermarkets
BUY YOUR ISSUE TODAY

 www.imaginesubs.co.uk/lud
*This offer entitles new UK Direct Debit subscribers to pay only £33.75 every 6 issues. Offer code PS172 must be quoted to receive this special subscription price. New subscriptions will start from the next available 

issue. Details of the Direct Debit guarantee are available on request. Subscribers can cancel this subscription at any time. This offer expires 30 June 2017.

Subscribe &

SAVE  
20%*

OFFER CODE: 

PS172



76

1 Navigate to a list  
Open an app where you are likely to have a 

long list of items that you will want to scroll 

through such as Music. Now position your 

finger over the Remote’s Touch surface.

2 Swipe down the right  
A few large swipes on the Remote will activate 

rapid scrolling on Apple TV. By swiping down 

the right edge of the Touch surface, you can 

also quickly scroll through lists.

3 Using an index 
Any lists which make use of an index can also 

benefit from fast scrolling. Large swipes back 

and forth will see you jump rapidly through the 

alphabet, avoiding thumb strain.

4 Third-party use 
The fast scrolling function can be accessed by 

third-party developers so it’s likely that many 

such as Netflix will take advantage, allowing 

you to jump through lists in chunks.

How to speed- 
scroll through 
Apple TV menus

Having to make lots of movements with your 

thumb on the Touch surface of the Apple TV 

Remote in order to navigate the menus can 

be a bit of a pain. Fast scrolling, however, 

makes life much easier by allowing you to make 

exaggerated movements in order to rapidly 

move around the screen. 

Accelerated scrolling has been integrated 

into tvOS 10.2 so you will need to upgrade the 

operating system of your Apple TV to the latest 

version in order to benefit from it. Once done, 

though, you’ll find a massive improvement, 

since it will allow you to get to the content 

you want much faster than before. Third-party 

developers are being encouraged to integrate it 

too so if you can’t use it right now in a favourite 

app, don’t worry: it’s bound to become 

commonplace before long. 

Activate the fast scrolling function to 

quickly jump through your lists

Apple TV

Quickly scroll through your contentStep-by-step

Download available

Time needed

2

Difficulty

If the Siri Remote’s Touch surface feels either 

too sensitive or not responsive enough you can 

customise it either way to best suit you.

1 Open the Settings app  
In the Settings app of Apple TV, go to Remotes 

and Devices and select ‘Touch Surface 

Tracking’ which you will find is set at Medium  

by default. You can change it to Slow or Fast.

2 Make your choice 
The Slow setting means you will have to move 

your thumb much further on the Touch surface 

to navigate the screen. Fast means using 

smaller movements, making it more sensitive.

Adjust the 
Touch surface 
sensitivity
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1 Open the Settings app  
The AirPods don’t automatically sync with 

Apple TV. So open the Settings app on your 

Apple TV and navigate down its main menu to 

select the option for ‘Remotes and Devices’.

3 Launch Bluetooth settings 
Back on your Apple TV, navigate to the Settings 

option for Bluetooth and select it. The device 

will begin looking for items it can connect with. 

Your AirPods should show.

2 Grab the 
AirPod case
With the  

AirPods inside 

the charging 

case, open 

the lid before 

pressing and 

holding the 

small, circular 

pairing button 

on the back  

until the light 

turns white  

and blinks.

4 Select your AirPods 
Select them and they’ll be paired with your 

Apple TV, letting you listen to its audio output. 

They’ll auto-reconnect if you don’t sync them 

with other devices in the meantime.

Use your AirPods with Apple TV

An iPhone or iPad will instantly pick up on a pair 

of AirPods but other devices, including Apple TV, 

will not. For those, you have to pair up manually 

but it’s worth doing because it means you’ll 

be able to use your AirPods to the max. That’s 

because with Apple TV there are other benefits 

to be had from using the AirPods as opposed 

to other buds. Audio and video will pause when 

you pop them out of your ears, for instance, 

and you can also double tap them for the same 

effect. Here we look at how you can establish 

the link between Apple TV and the AirPods but 

if you need to unpair for any reason, just go to 

Settings>Remote and Devices>Bluetooth>Your 

Airpods and tap ‘Forget Device’.

Enjoy your movies and music without disturbing others

Apple TV

Pair AirPods with Apple TVStep-by-step

Download available

Time needed

2

Difficulty

If you can’t hear a sound, it probably means 

your Apple TV’s Audio Output is not set to your 

AirPods. Correcting in the Settings app is easy.

1 Find Audio Output  
In the Settings app of Apple TV, select ‘Audio 

and Video’ from the main menu and look at 

the entry displayed next to Audio Output. If it 

doesn’t say ‘AirPods’, then select it.

2 Choose your AirPods 
You will see at least two options: to output via 

Apple TV itself or your AirPods. Move down the 

list and select the AirPods. Use ‘+’ and ‘–’ on 

the remote to adjust the volume.

Changing the 
Audio Output
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Genius Bar
Our Apple devices and the software on them are some of the finest 

products on the planet, but even they have their moments. We’re here  

to give you expert advice and get you back up and running in no time

I accidentally deleted a Mail email draft that I had been working 
on for quite a while – can I get it back?  Kevin Hill

Apple Music 
This is Apple’s 

subscription-based music 

streaming service that lets 

you listen to any music 

whenever you want to. You 

can also listen to specially-

curated playlists to suit 

any mood or occasion.

Email draft 
When composing a new 

email you can save it 

as a draft to finish later 

by retrieving it from the 

‘Drafts’ mailbox in Mail.

iCloud Drive
This is where important 

macOS and iOS data is 

stored in the cloud and 

made accessible for other 

devices connected to the 

same iCloud account.

Parental Controls 

This is a section in 

the macOS System 

Preferences that lets you 

set up new accounts for 

children and then limit 

what they can access, in 

terms of web content, and 

how long they can spend 

on the Mac at any time.

All is not lost if you 
accidentally delete 
an email draft…

1 A common mistake
Unfortunately, if you highlight text 

to delete in a draft email without 

it being opened in a separate 

window then you will delete the 

entire draft, not the text within it. 

2 Double-click
When editing draft emails, always 

double-click on the draft within 

the ‘Drafts’ mailbox to open it in a 

separate window. This will avoid 

the risk of the draft getting deleted.

3 Check ‘Trash’
If your draft is accidentally deleted 

from the Drafts mailbox then click 

on the ‘Trash’ mailbox and the 

draft should be retrievable from 

there. Click and drag to ‘Drafts’.
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1 Go to Preferences
Go to System Preferences and 

click the ‘Parental Controls’ pane. 

Create a new account for your 

child, providing the required info.

2 Click ‘Web’ tab
You will arrive at the main Parental 

Controls window that provides 

extensive control over a range of 

features. Click on the ‘Web’ tab.

3 Set limitations
You can now click to limit access to 

adult sites or just list the only sites 

that your child will have access to. 

Click the padlock when finished.

How do I set up Parental Controls on my Mac to limit the internet 
sites that my child is able to access? Sarah Ashworth

What is the quickest and easiest way of clearing my  
Safari history in macOS Sierra? Jeremy Sutton

The one-stop 
column for  
Genius advice

My Mail app is 

constantly showing 

that it is downloading 

messages in the activity 

pane. This has been 

going on for a few 

weeks. Is there any way 

to stop this?

Start off by clicking on 

the ‘Window’ menu bar 

item within the Mail app 

and select ‘Activity’. This 

will bring up an activity 

monitor that will show 

if any messages are 

currently downloading. If 

this is clear then it may 

be time to rebuild and 

reindex your Mailbox. 

Start off by clearing your 

Junk and Trash mailboxes 

and then click on the 

‘Mailbox’ menu bar item 

within the Mail app and 

select ‘Rebuild’. You 

will need to do this for 

each mailbox and the 

process can take hours, 

rendering your Mac less 

responsive than usual. 

As a last resort, you 

can try reindexing your 

mailboxes. To do this, quit 

the Mail app and then 

hold the Option key and 

then in Finder choose 

Go>Library. Now navigate 

to Mail/V2/MailData 

and remove any file that 

begins with ‘Envelope 

Index’ and place it in a 

separate folder on your 

desktop. Now relaunch 

the Mail app and it will 

build new Envelope Index 

files. This takes time but 

should fix the problem.

Apple 
Expert

This is a slightly strange request, 

but is there a way to reset the 

voices in the Chess app? When I updated 

to macOS Sierra the list of voices in the 

Chess app changed to a completely 

different set. Stuart Jones

We presume that you‘re referring to the novelty 

voices (Bells, Bad News etc)? In which case 

you would need to copy them from an install 

disc or backup of macOS El Capitan (or earlier) 

into the /System/Library/Speech/Voices folder 

in macOS Sierra.

In Safari you can limit which websites send you notifications. Go to your 
Safari Preferences, click on ‘Notifications’ and then allow or deny them. 

 History menu
The quickest method is 

to click on the ‘History’ 

menu bar option and 

then select the ‘Clear 

History’ option from the 

bottom of the menu.

 Safari Preferences
You can also click on the 

‘Safari’ menu bar item and 

choose ‘Preferences’. Now 

click on the ‘General’ tab and 

you will see an option relating 

to the removal of history items.

 When to remove
Use the menu here to automatically 

remove history items after one day, 

one week, two weeks, one month or 

a year. Choose the option that suits 

your needs and close the window.

 Clear prompt
When you select the ‘Clear History’ 

option a box will appear. Here you 

can tailor exactly how much of your 

Safari history is deleted. For example, 

you can delete history from the last 

hour, day or the last two days.

It is possible 
to restore the 
novelty voices to 
the Chess app…
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Genius Bar

The one-stop 
column for  
Genius advice

I have switched to 

using WhatsApp as my 

main texting app and 

wondered if there was 

a quick way to clear 

messages instead 

of deleting them 

individually or in batches 

by pressing and holding 

on a message?

Mercifully, yes. Instead 

of pressing and holding 

on a message and then 

choosing the ‘Delete’ 

option, back out of the 

conversation until you are 

on the main Chats screen 

and then swipe left on a 

chat. Now tap on ‘More’ 

and choose the ‘Clear 

Chat’ option.

My iPad mini needs to 

be updated to iOS 9.2.1 

so that I can download 

some newer apps. 

However, when I try to 

update the operating 

system it says, “Failed 

verification because you 

are no longer connected 

to the internet”. But I 

am! Can you help?

This is because Apple 

no longer supports iOS 

9.2.1. The current, and 

last, supported update 

for your 1st generation 

iPad Mini is iOS 9.3.5 so 

you will need to update 

to that. You can either do 

this on your iPad by going 

to Settings>General> 

Software Update or by 

connecting your iPad up 

to the latest version of 

iTunes on your Mac.

Apple 
Expert

I have heard that I can access files from my Mac desktop  
on my iPad by saving them to iCloud Drive. Is this possible?  
If so, how do I go about setting it all up? Paul Fletcher

1 Update OS
Start off by ensuring that both 

your Mac and iPad are running 

the latest operating systems (Mac 

OS 10.12.4 and iOS 10.3.1).

4 Turn on feature
You should now see an option 

called ‘Desktop & Documents 

Folders’. Tick the box next to it 

and it will start setting up.

2 Turn on Drive
Next, go to Settings on your iPad 

and then, under ‘Apple ID, iCloud, 

iTunes & App Store’, tap ‘iCloud’ 

and then turn on iCloud Drive.

5 Increase storage
You may get a notification that 

you need to purchase more 

iCloud storage to enable this 

feature, but it is fairly cheap.

3 Go to Options
On your Mac, go to System 

Preferences>iCloud and then click 

on the ‘Options’ button next to 

iCloud Drive.

6 Open Drive
Now, on your iPad, open the 

iCloud Drive app and you will 

see a new folder within called 

‘Desktop’ – tap to access it.
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Is there a way to disable Apple Music so that my iPhone 
Music app only displays songs on my iPhone? Emma Coburn

1 Go to Settings
Start off by going to your 

iPhone’s Settings app and 

then scroll down and tap on 

the ‘Music’ settings some way 

down the page.

2 Turn off ‘Show’
At the top of the Music 

settings screen is an option 

called ‘Show Apple Music’, 

turn this off and then quit 

Settings and launch Music.

3 Your music
The Music app interface will 

be streamlined. To access 

your own music, tap on the 

‘Library’ tab and then choose 

‘Downloaded Music’.

Go to Settings>General to assign a function to the side switch on your iPad. 
The alternate option will then be available by swiping up to Control Center.

I could really do with freeing up some space on my 
iPhone by deleting music. What would you say the 
quickest and easiest way of doing this is? Cian Evans

I was wondering if there was a 

way to turn off the shutter noises 

that go off every time I take a picture 

through my iPhone’s Camera app?  

It can get rather annoying…  

James Crichely

There is, but it’s not as straightforward as 

you would hope. You’d think that the option 

to turn off camera sounds would reside in 

the Sounds settings, or maybe the Photos & 

Camera settings? No, because no setting to 

mute the sound of the Camera app exists. 

Instead, you have to activate the ‘mute’ 

switch on the side of your iPhone manually 

in order to cut the sounds coming from the 

Camera app. Sort it out, Apple.

I have heard that my iPhone 

comes with a built-in spirit level, 

but I can’t seem to find it amongst all  

of the apps… Sam Sykes

It’s certainly not a particularly well signposted 

feature but yes, your iPhone does indeed 

come with a built-in spirit level. To access 

it, launch your Compass app (which is 

located in the Extras folder by default) and 

then swipe to the left on the main compass 

screen. This will reveal the spirit level screen. 

The interface is somewhat primitive and 

could certainly do with updating, but it does 

the job in an emergency. Simply hold your 

iPhone against any surface to get a level 

percentage figure and a level indicator.

 Swipe left
To delete music, swipe left 

on an album and tap the 

‘Delete’ option to remove 

it. Alternatively, tap on 

an album and then swipe 

left on individual songs to 

start removing them.

 Space 
remaining
The figure at the 

bottom of the screen 

tells you how much 

space you have on 

your iPhone. If you are 

freeing up space for 

a particular reason, 

such as to download a 

new app, you can stop 

deleting content when 

you hit that figure.

 Go to Storage 
& iCloud Usage
The best method of 

deleting music is to go 

to Settings>General> 

Storage & iCloud 

Usage and then tap 

‘Manage Storage’ 

followed by ‘Music’.

 Total space 
used by music
The figure in the top-right 

corner is the total amount 

of space taken up by 

music on your iPhone.  

If this seems obscenely 

high then it is probably 

time to start freeing up 

some space. Start with 

songs you haven’t listened 

to in a long time. 

The Camera app doesn’t have a mute 
option so mute your iPhone manually
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1 Unclip the battery
Place your MacBook upside down on a flat surface 

and then press up on the two tabs that are either 

side of the detachable battery.

2 Remove the battery
The edge of the battery should now be unclipped 

and raise up slightly, allowing you to lift it up and 

carefully remove it from the casing.

3 Undo the screws
You should see three identical 2mm PH000 Phillips 

screws securing the memory door. Unscrew and 

remove these and then store them in a safe place.

4 Remove the RAM door
Once unscrewed, lift the memory door up high 

enough to grip and then slide it towards you, pulling 

it away from the casing.

5 Release old RAM
Release the tabs on each side of the RAM chip at 

the same time. These tabs lock the chip in place 

and releasing them will cause the chip to pop up.

6 Remove and replace
Pull the chip directly out from its connector and 

then carefully insert and clip in the replacement 

RAM, reversing the process to reassemble.

I have a MacBook Pro 15” Core 2 Duo 
A1226 Model and wanted to know how 

to increase the RAM… Sean Slater

Replacing the RAM in MacBooks is generally a 

painless affair. The model you own comes with 

2GB of RAM installed as standard and you can 

upgrade this to a maximum of 6GB. Replacement 

RAM chips are available in 512MB, 1GB, 2GB and 

4GB, so to achieve the maximum you would need 

to insert one 4GB chip and one 2GB chip, which 

would cost in the region of £100 in total. The only 

tools you need to carry out this task are a Phillips 

#00 Screwdriver and your fingertips and the entire 

replacement process shouldn’t take you any longer 

than five minutes tops.

Genius Bar

The one-stop 
column for  
Genius advice

How do I turn on private 

internet browsing in 

Safari on my iPhone?

In Safari, tap on the tabs 

icon in the lower-right 

corner to display all open 

Safari tabs. Next, tap on 

‘Private’ in the lower-left 

corner (the interface 

should go dark) and then 

tap the ‘+’ icon to open a 

new private tab. To 

disable this, tap the tabs 

icon, close the private tab 

and then tap ‘Private’ (the 

interface should go light). 

I have only had my 

iPhone 7 for six months 

but already my fully-

charged battery is dying 

in about two hours. How 

can I prevent this?

On your iPhone, go to 

Settings>Battery and you 

will be given a rundown of 

what apps and services 

have been draining your 

iPhone’s battery. You may 

also have certain apps 

open that refresh in the 

background, so check out 

the settings for apps such 

as News and then turn off 

the ‘Background App 

Refresh’ options.

How do I find out the 

serial number for my 

new iPhone? 

Go to Settings>General 

and you will see an option 

at the top of the page 

called ‘About’. Tap on this 

and all of the important 

facts and figures about 

your iPhone will be listed.

Apple 
Expert
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Tools needed
Missing any of these? 

You can order any 

parts or tools you 

might need from  

www.ifixit.com/store.

•PlasticSpudger
•P5Pentalobe

Screwdriver

•Phillips#00
Screwdriver

•T5TorxScrewdriver

My 14-year-old daughter is desperate for her first laptop, and I  
can’t bring myself to buy a Windows computer. I’ve seen a good 

dealona2013MacBookAir–anygood?Richard Scarborough

 The battery
Every battery has a shelf life, 

and an older MacBook Air is 

no different. Replacing it is a 

fairly straightforward task – 

disconnect the battery from the 

logic board and then remove 

five screws connecting the 

battery to the upper case.

 Microphone
It’s not an obvious part to replace, 

but a 14-year-old is soon going to 

notice a faulty microphone when 

they’re trying to FaceTime their 

friends. The multi-purpose  

Spudger tool will be your best  

friend in this fiddly and time-

consuming replacement.

 Solid-state drive
Although much more reliable 

then their mechanical 

predecessors, freshening up 

a tired SSD can reap huge 

performance benefits. It’s an 

expensive upgrade, but it only 

takes two screws to be taken 

out to put a new one in – just 

be careful.

 Trackpad
It’s obviously a part of the MacBook that 

gets a lot of use and therefore it might need 

replacing. In truth, it’s a pain to get to – there 

are various other parts to remove before you 

get to it – but it still only ranks as a moderate 

level difficulty replacement with iFixit.

 Fan replacement
It’s not the worst idea to get a MacBook’s 

fan and give it a good clean out. It’s amazing 

how much dirt can get clogged up in there. 

The fan is well-protected by the I/O board, 

but once you have removed that it is easy to 

pop out and take a look at.

We obviously think you’re doing the right thing by going down the Apple route, and you can certainly save 

a lot of money by getting a Mac that is a few years old. We delved into the archives to find that our friends 

at iFixit did a teardown on the 2013 MacBook Air and rated its repairability as 4/10. Not the best, but they 

also said that once you’ve got the back off, pretty much everything can be replaced. And let’s be honest, 

any 14-year-old is likely to give a Mac some unwanted wear and tear. Here’s what you can upgrade/

replace on that model of MacBook Air…

Don’t forget that you can find repair and upgrade guides to every part 
mentioned here over at ifixit.com.

If you would like more help with upgrading your Mac, visit the gadget 
surgeons at iFixit.com, who kindly contributed these photos.
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Group test

USB storage 
solutions

Vx400  
USB 3.0 Drive 

£75.99/$99.99

verbatim-europe.co.uk

This USB drive is available in 256GB and 

128GB versions (the latter is reviewed here), 

and it’s a formidable beast for transferring data 

quickly and easily. The small, compact unit 

weighs just 16 grams and is housed in a sleek 

metal casing complete with a switch to move 

the USB connector in or out. The Vx400 is also 

capable of read speeds of up to 400MB/sec 

and write speeds of up to 200MB/sec when 

plugged into a USB 3.0 port and is very useful 

for backing up vast chunks of data, including 

photos and music, and for editing and sharing 

large 4K video files. A good, reliable device for 

all of your data backing up/transporting needs. 

iStore ‘n’ Go  
USB Drive 

£55.99/$75.99

verbatim-europe.co.uk

Available in 16GB, 32GB and 64GB  

versions (the latter is reviewed here), the 

iStore ‘n’ Go, despite its crappy name, is 

actually a brilliant  USB Drive that can add 

external storage to your iPhone. The device 

is double-ended, so you can plug the USB 

end into your Mac to transfer data (such as 

filling the device up with music, photos or 

video files), and then unplug it and connect 

the Lightning 8-pin connector end with your 

iPhone to massively enhance the storage. 

The perfect way to free up space on  your 

iPhone by keeping your media separate. 

USB V3 Max 
£13.99/$18.99

verbatim-europe.co.uk

Anyone in the market for a good, robust and reliable USB 

flash drive with which to backup data and quickly transfer 

files should look no further than the V3 Max. Available in 

16GB (reviewed here), 32GB, 64GB and 128GB versions, it 

is capable of transfer speeds of 175MB/sec when plugged 

into a USB 3.0 port and the ‘slide and lock’ mechanism 

protects the USB connector when not in use. It comes in 

a smooth, polished finish and weighs just 10 grams, but 

lacks the same high transfer speeds and dual-use aspects 

of the other, better drives featured in this group test.
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OTG  
Micro Drive

£32.99/$42.99

verbatim-europe.co.uk

Looks can be deceiving as far as the OTG Micro Drive 

is concerned. Its microscopic size made us think it was 

a standard USB 2.0 drive of limited capacity. However, 

weighing in at just 3.6 grams, this unit packs in 64GB 

of storage space (it is also available in 16GB and 32GB 

versions) and features dual interface high speed USB 3.0 

and MicroUSB capable of transferring data at speeds up 

to 110MB/sec. So small it could easily be misplaced, it 

does, thankfully come with a keyring and lanyard.

Metal Executive  
USB 2.0 Drive

£13.99/$18.99

verbatim-europe.co.uk

Available in 16GB, 32GB (reviewed here) and 

64GB versions, the Metal Executive may lack 

the super-swift transfer speeds of some of the 

other flash drives featured here, but its micro 

design and weight (3.6 grams) make it an 

absolute breeze to ferry around (it even comes 

with a metal keyring). Finished in stylish silver, 

the unit is sturdy, dustproof and waterproof 

and is ideal for transferring large files between 

computers and performing quick and easy 

backups of modest bundles of data.

Dual USB Drive –  
OTG/USB 2.0 

£9.99/$12.99

verbatim-europe.co.uk

Available in 16GB (reviewed here), 32GB 

and 64GB versions, the Dual USB Drive is 

just that – a double-ended storage device to 

which you can transfer documents and data 

quickly and easily. The compact design is 

deceiving as you can’t instantly fathom where 

the standard USB connector is, but if you 

pull the black plastic cover away from the 

rear of the unit then all will be revealed. The 

microscopic size of the unit makes it a loss 

risk, but it does come with a keyring to help 

give you a fighting chance of holding onto it.
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Not suitable for all-out gaming, but it’s a great-looking big screen 

to connect your laptop up to.

BenQ IPS LED Monitor  
£120/$140

Verdict

Key features

23.8-inch•1920x1080FHD•WideviewinganglewithIPSTechnology
Learn more

benq.com
Available from

amazon.co.uk

The GW2406Z IPS LED monitor from BenQ provides 

178°/178° wide-viewing angles and offers flicker-

free, uncompromising image quality that won’t melt 

your eyeballs. Taking on board Bauhaus’ ‘less is 

more’ minimalism design philosophy, this monitor 

shuns needless gimmickry and unifies simplicity 

and functionality into pure aesthetics. As such, it will 

look at home anywhere in the home. It also features 

BenQ’s exclusive eye-caring technology, flicker-free 

feedback and unique Low Blue Light Technology, 

which filters out harmful blue light, thus reducing  

eye fatigue and irritation through staring at it for 

lengthy periods of time.

The monitor also comes with IPS (In-Plane 

Switching) Technology, which presents accurate 

colour and image reproduction from any angle, so 

it’s a reliable monitor for presenting work to multiple 

people in the same room. We have road-tested this 

monitor throughout the last month, connecting up 

a MacBook Pro to it and the results have been very 

pleasing. It presented our Mac desktop in a sharp 

1920x1080 resolution and we suffered none of the 

normal eye fatigue we may experience when looking 

at a screen for long stretches.

If you’re considering purchasing a monitor for all-

out gaming then you should probably look elsewhere 

as the IPS screen doesn’t boast the same response 

rates of TN panels, but it’s fine for general use. Other 

slight drawbacks are the adjustability (we were limited 

to tilting the screen backwards or forwards) and the 

lack of gamma or colour temperature presets in the 

onscreen menu. The arrangement of the buttons 

tucked away underneath the monitor also means that 

you will inevitably press the wrong thing while feeling 

around for them initially. But it’s certainly a decent 

multipurpose monitor for the price.

Theconnectionpoints,includingVGA
D-Sub,DisplayPort1.2andHDMI1.4,are
hiddenawayunderneaththemonitor

Thestandofthemonitorpivots
backwardsandforwardsformultiple
viewingangles

Withitsminimalisticdesignandglossy
blackfinish,thisstylishmonitorwill 
lookgoodanywhere
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Based in Stockholm in Sweden, Urbanista takes 

inspiration from urban city life in designing and 

manufacturing its extensive range of sporty audio 

headgear, which is why all of its headphones and 

earphones are named after global cities, such as 

Seattle, Oslo, Rio, Boston and now Rome.

There is certainly much to like about Urbanista’s 

new Rome earphones. They wirelessly blast music 

into your ears via Bluetooth 4.0, they hold up to 600 

hours of battery stand-by time, provide up to 16 

hours of continuous play and feature magnetic ends 

for convenient storage when not in use. They sound 

great too: crisp, well-balanced with a satisfying pulse 

of bass, keeping the sounds contained rather than 

exposing anyone nearby to what you are listening to. 

When not in use, you can simply pop the plugs out of 

your ears and let them dangle over your chest thanks 

to the handy neck band, which is fully water-resistant 

– perfect for rainy day runs or particularly sweaty gym 

sessions. The neck band features button controls and 

a mic on the right side, allowing you to control the 

volume and talk hands-free on your iPhone.

Included in the (rather lavish) box is a small USB 

charging cable and a silk-lined carry case. Simply 

connect the earphones to an iPhone charger and 

lights will indicate when it is taking on charge and 

when it is good to go. In terms of performance the 

Rome earphones are faultless. The only criticism 

we do have, which is a very minor one, is that the 

magnetic ends aren’t strong enough to be truly 

useful in helping you attach the earphones to a 

metal surface for storage. We flung them at our 

refrigerator door expecting them to stick (and making 

it a convenient, central location in the house to store 

them), but they just slid agonisingly to the floor. Apart 

from this though, the Rome earphones are a robust, 

durable and fashionable way to listen to your favourite 

music on the move.

A stylish and great-sounding set 

of Bluetooth earphones that are 

a lot harder to lose than a set of 

AirPods. Highly recommended 

for any purpose.

Urbanista Rome 
Bluetooth Earphones 

£59.99/$79.99

Verdict

Key features

Bluetooth4.0•600hoursstand-bytime•16hoursofcontinuousplayback
Learn more

urbanista.com
Available from

amazon.co.uk

Theendsoftheearphonesare
magnetisedforeasystorage,butwe
foundthemineffective…

Theearphonesdowelltocontainthe
noiseandnotsubjectanyonenearbyto
yourtasteinmusic

Controlsontherightsideoftheneck
bandletyouadjustthevolume,charge
andtalkhands-free
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An ergonomically sound, alternative wireless keyboard that, sadly, 

no Apple user would seriously consider using.

Penclic  
Mini Keyboard K2  

£54.99/$75.99

Verdict

Key features

HelpsreduceRSI•HID1.1(nodriversneeded)•Wireless
Learn more

penclic.se
Available from

amazon.co.uk

Combining contemporary Scandinavian design, 

superior ergonomics and function, the purpose of 

the Mini Keyboard K2 from Penclic is to place you 

in a better working position at your computer. The 

keyboard’s compact size allows you to position your 

hands to help reduce repetitive strain injuries (RSI) 

while working. The keyboard is also wireless up to 

five meters – though not, as you would expect, via 

Bluetooth. Packaged with two AAA rechargeable 

batteries, a USB charging cable and a Nano-USB 

Receiver, you must charge up the keyboard prior to 

use and plug the receiver into a USB port on your 

Mac – at which point a Keyboard Setup Assistant 

will appear on screen. It only takes a minute or so to 

set up with Macs that support HID 1.1, as no driver 

software is required.

The keyboard is responsive to use and the 

quiet-touch keys help minimise the noise of frantic 

typing, but anyone used to using a more expansive 

alpha-numeric keyboard may feel restricted by this 

keyboard’s limitations. The layout is very similar to 

Apple’s Magic Keyboard (but with only one Command 

key) and two feet on the underside flip down to 

elevate the keyboard into a friendlier typing position.

In terms of design, the front of the keyboard slopes 

upwards to accommodate the battery compartment 

and this extra space also houses a useful battery 

monitor light on the top to let the user know when 

it requires recharging. It’s worth mentioning that 

this should be reassuringly infrequent as a charged 

battery can last up to two months!

The benefits of using this keyboard are, however, 

offset by the fact that it just looks cheap and nasty, 

like an oversized 90s pocket calculator that no self-

respecting Apple user would pass by an official 

product for. Shame, because it works really well.

ThekeyboardwasdesignedinSweden
andconsistsofsubduedcolourstohave
arelaxingeffectontheuser

Twofeetontheundersideofthe
keyboardflipdowntoelevateittoa
morecomfortabletypingposition

Abatterylightmonitoronthetopofthe
keyboardletsyouknowwhenitneeds
recharging,whichshouldn’tbeoften…
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At first glance, this Mac add-on looks like it should be 

trundling unconvincingly around a 70s Doctor Who 

set, or splattered with blood and worn atop the head 

of a Game Of Thrones character. But when you clasp 

it in your hand, everything fits into place…

The Evoluent C is actually a luxurious, ergonomic, 

right-handed vertical mouse, the unique design of 

which reduces the angle between the wrist and 

hand for a more ergonomically responsible position. 

With a less convex shape to fit the palm better, 

increased comfort is assured and the shape of the 

mouse keeps the wrist from bending as much to the 

side while the forearm also turns inward to a lesser 

degree. This means that muscle activity in the forearm 

is less than it would be when using a conventional 

mouse. While holding the mouse, your thumb slides 

snugly into an indented groove on the left side while 

your index and first fingers rest over the repositioned 

left and right-click buttons (with a scroll wheel 

situated between the two). It feels very comfortable 

to use, unsurprisingly, but the urge to push down 

to trigger clicks is hard to fight for the first couple of 

hours of use. You can also operate the clicks using 

your thumb as two buttons are also positioned above 

and below the thumb groove. It suits pretty much any 

style of use you could imagine.

The mouse can be plugged into a USB slot on 

your Mac and used immediately, but you can also 

download the Evoluent Mouse Manager app to help 

you configure the buttons to do different things to suit 

your needs. It’s a versatile beast that is capable of 

pretty much any configuration you can think of.

There are a couple of issues we have with it, but 

these are almost childlike when you consider the 

ergonomic benefits that this product offers. Okay, 

here goes… The wire length is excessive – there’s 

enough here to lasso a wild colt – and it feels far too  

lightweight and cheap to warrant the lofty price tag. 

It takes a little adjusting to, but the ergonomic benefits that this mouse offers make  

it a viable, albeit expensive alternative to your standard Mac mouse.

Evoluent C  
Vertical Mouse 

£150.99/$195.99

Verdict

Key features

ReducestheriskofRSI•Right-handed•Fullyconfigurable
Learn more

bakkerelkhuizen.com
Available from

amazon.com

TheEvoluentCiscomfortabletohold,
buttakesalittlegettingusedtoafter
usingaconventionalmouse…

WhenattachedtoaMac,thelogoand
aseriesofsmalldotsonthetopofthe
mousewilllightupblue

TheEvoluentCfeaturesaleftandright-
clickbuttoneithersideofascrollwheel
ontheright-handside
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Accessories
MP211 Portable 

Speaker
£33.99/$43.99

edifier.com

This compact portable speaker from Edifier 

is lightweight and easy to transport (ideal 

for summer beach trips and festivals) and 

features easy connectivity via Bluetooth 4.0, 

SD card or 3.5mm AUX input. It also comes 

with a built-in microphone, so you are able to 

make and answer calls through the speaker. 

Available in five colours, the device features 

a handy wrist strap for easy transportation 

and can kick out a decent level of sound that 

makes it perfect for small outdoor gatherings. 

Slimline Tan Gold 
Leather iPhone 7 Case

£22.95/$29.95

snakehive.co.uk

Made from top-quality genuine leather, this 

slimline wallet case has been designed to 

offer premium protection for your beloved 

iPhone 7 and features a secure magnetic 

closure mechanism to keep it from flapping 

open if you drop it. The back cover of 

the case folds into itself horizontally to 

provide a kickstand and there is also a 

handy compartment for cards. The dappled 

texture of the case feels great to touch 

and it looks very smart and respectable. 

iBeani iPad Stand
£24.99/$34.99

ibeanie.co.uk

It seems audacious, shrinking a beanbag 

and then marketing it as an iPad stand, but 

it actually works very well – especially for 

resting on your lap and watching movies or 

TV through your iPad. There are 42 different 

design variants available and the traditional 

squishiness of the beanbag means you 

can obtain any viewing position or angle 

you could imagine. Of course, it’s not just 

limited to iPads, you can use the iBeanie to 

prop up books, cameras or small pets too!

Reviews
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Numpad N2
£24.99/$32.99

penclic.se

What are the advantages of purchasing a separate 

numerical pad for your Mac? Well, if you require 

frequent access to one and only own an Apple Magic 

Keyboard (or, indeed, Penclic’s own Mini Keyboard 

K2 reviewed on page 88) then this product may be 

worth considering. Likewise, if you are an accountant 

and want a detachable numerical pad that you can 

position in the perfect place for your work then it could 

also be useful. The pad comes with a wired-in USB 

cable, cushioned rubber pads on the underside and 

a soft typing action. It’s certainly a decent product 

and may come in handy for certain professionals.

TravelKit Bag
£29.99/$38.99

penclic.se

The only really constructive thing we can 

say about the appearance of Penclic’s carry 

case is that it looks so cheap that would-be 

muggers wouldn’t for one moment think that 

you are carrying anything expensive inside 

– it doesn’t exactly scream ‘premium’. To be 

perfectly fair though, this case isn’t designed 

for MacBooks or iPads; it is marketed purely 

as a means to carry around all of Penclic’s 

ergonomic computer accessories (such as 

the Numpad N2, reviewed here, and Mini 

Keyboard K2). Quite why you would want 

to fork out for a case specifically for that 

purpose is another matter altogether…
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Your ultimate rig
Build up your own fantasy stomp 

box rig and add to it with in-app 

purchases to bolster your sound

Loop sections
You can record parts and loop 

them to flesh out your sound and 

gradually build up compositions

Bang the drums
You can also loop in percussion. The 

new update adds rest blocks to the 

drum loops for a more natural sound

3 Key Features

“AmpliTube can 
make even  

the cheapest  
of guitars  

sound great”

An essential, sonic selection box for guitarists with enough scope to help you realise 

those noises in your head and transform them into rounded compositions.

AmpliTube for iPad
£19.99/$19.99

Verdict

Requirements 

iOS8.0orlater•iPad(iPhoneversionavailable)
Learn more 

ikmultimedia.com

Available from 

iOS App Store

Although IK Multimedia’s excellent 

AmpliTube app has been available on  

iOS for several years already, we felt that 

the recent free update and the bolstering 

of new gear available via in-app purchases merited a 

stock-taking review.

In case you aren’t familiar with AmpliTube, it invites 

you to connect your electric guitar or bass guitar to 

your iOS device via the iRig adaptor (sold separately) 

and then use the vast selection of in-app amplifiers 

and stomp boxes to obtain pretty much any tone or 

effect you could desire. Then, like GarageBand, you 

can record your guitar feeds, loop sections to build 

up a multi-layered wall of sound and set them to 

percussion to really flesh out your casual noodling. 

There is plenty of fun to be had experimenting with 

the sounds and you can even manually position the 

mics around the cab for the optimum studio sound 

that you are trying to achieve. With well over 100 

pieces of kit available straightaway or via in-app 

purchases you could spend thousands trying to even 

get close to mimicking these tones real life.

AmpliTube’s 4.4.0 update adds new free effects, 

including Swell, Electric Flanger, Crusher, Dcomp, 

Feedback and Phazer10 and a few new amps in 

the British Copper 30TB, Vintage Metal Lead and 

360Bass. It also expands the in-app purchase 

options, with the Fender Collection 2 amps being a 

noteworthy addition.

What really makes this app so essential for any 

guitarist is that it can make even the cheapest of 

guitars sound great and you can get really creative 

with your setups thanks to the 100+ pieces of kit 

available to achieve more wah, distortion and sustain 

than you could possibly imagine. AmpliTube is 

undoubtedly a must-have app for iOS musicians  

that will go some way to help you realise those far-

fetched fantasies of rock-god grandeur. Just be 

warned, however, that you will discover it can be a  

bit of a battery-drainer. 
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Stylish interface
Turn the pages to select a city and  

it will be rendered before your  

eyes in 3D blocks

View from above
See some of the world’s most 

famous cities from incredible new 

angles. Use the dots to jump around

Globe-trotting
An in-app map displays all of the 

featured locations and you can jump 

straight to them from there too

3 Key Features

A beautifully-presented app that showcases some of the world’s most visited cities 

through a series of stunning aerial images that you can fully explore.

AirPano City Book  
– 360° Virtual Travel

£2.99/$2.99

Verdict

Requirements 

iOS9.0orlater•iPhone,iPadandiPodtouch
Learn more 

citybook.airpano.com

Available from 

iOS App Store

AirPano is the world’s largest resource of 360° 

bird’s-eye view panoramas that have been lovingly 

compiled by a team of Russian enthusiasts who 

specialise in taking high-resolution images from 

helicopters, blimps, hot-air balloons and drones. To 

date AirPano boasts a collection of more than 3,000 

aerial panoramas of more than 300 locations around 

the globe, and this app lets you explore ten of them in 

stunning detail (with plenty more to come soon).

From the main menu, you can turn the pages of 

a book to reveal the next city, which is then stylishly 

rendered in 3D blocks before your eyes. Tap on the 

‘up’ arrow and you will jump straight to the images, 

which are absolutely amazing. You can use your 

fingers to pan around the images, taking in the 

stunning spectacle that seduces you from all sides 

and then tap on dots positioned around the image to 

jump to new points to explore from. There is a vast 

selection of aerial images to view from the featured 

cities (which include Rome, Barcelona, Amsterdam, 

Shanghai, Buenos Aires, Singapore, Dubai, Paris and 

New York), each providing different points of interest, 

lighting conditions etc, and these can be swiped 

through at the bottom of the screen.

Though the limited selection of locations, at 

least initially, is a concern, those that are here are 

beautifully represented by the 15-or-so panoramic 

images featured. It is also immensely satisfying 

exploring the cities from above and you can 

manipulate the images simply by tilting your iOS 

device and locking the axis so that you can rotate the 

images full circle without moving your eye level.

So while interest is slightly limited by the current 

content, the app serves both as a means of 

appreciating stunning architecture from previously 

unseen angles and for triggering happy memories of 

places you have visited and experienced first-hand. 

And it’s a great way to see the world. “There is a vast 
selection of 

aerial images to 
view from the 
featured cities”
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New factions bring new weapons 

and tactics. Here a female vampire 

rides into battle on a zombie dragon

In campaign mode you must work 

with other factions to overcome the 

leader of the Chaos Hordes

The aim is to build settlements, 

research technologies and develop 

devastating weaponry

3 Key Features

Combining the intricacies of warmongering with the fantasy realms of Warhammer  

was a masterstroke and the result is stunning.

Verdict

Total War: Warhammer
£48.99/$59.99

Learn more 

Feralinteractive.com

Available from 

Mac App Store

Familiarity breeds contempt and as good 

as the last couple of Total War outings 

have been, the military resources of 

the featured factions could never really 

deviate from what history has told us, and they 

started to feel a little restrictive. But in taking the Total 

War formula and applying it to Warhammer’s vast and 

unpredictable world, the possibilities to experiment 

with new tactics and weaponry with interesting new 

characters are plentiful – and the fun flows back 

through the game as a result.

Traditionally, in Total War games you control one 

faction, build settlements, research new technologies 

and assemble armies. These armies then battle it out 

in real-time skirmishes against opposing factions. 

The preparation that goes into the battles is deep 

and compelling and the introduction of Warhammer’s 

fantasy races into the pot means that players can 

now employ giants, magic and even zombie dragons 

in the fight for supremacy. It’s never boring.

Of the five factions, the humans and the dwarfs 

play most like Total War games of old, but Vampire 

Counts, Orcs & Goblins and Chaos Hordes add some 

much-needed jeopardy into the proceedings, not just 

in the new fighting dynamics that they bring, but in 

how you play against them as an opposing faction. 

The Vampire Counts, for example, deploy zombie 

‘grunts’ to soak up the heavy rounds of enemy 

artillery. But the game is well-balanced and no one 

faction is super-charged enough to walk over the rest.

The game looks stunning and the battles erupt 

from the screen. There is also an interesting story that 

plays out through the campaign and the awesome 

online multiplayer to get stuck into whereby you can 

pit your warmongering wits against the masses. 

Highly recommended.

“Players can now 
employ giants, 

magic and even 
zombie dragons 

in the fight for 
supremacy”

Requirements 

macOS10.12.4•2.0GHzProcessor•8GBRAM•1.5GBGraphics
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Your race engineers will be your best 

friends, offering essential advice to 

get you better results

Use a keyboard? Expect to see this 

a lot. Pair up your game controller 

right now!

Nothing will compare to winning 

your first Grand Prix and lifting  

the race trophy

3 Key Features

F1 2016 is galvanised by a brand new Career Mode that finally gives some sort of 

longevity to motor racing on your Mac.

Verdict

F1 2016
£48.99/$59.99

Learn more 

feral.com

Available from 

Mac App Store

It’s been three long years since F1 fans had the 

chance to enjoy a new Mac game, but with F1 

2016 the wait for speed fanatics is finally over. Its 

predecessor was a stripped-back game with a few 

frustrating omissions, but we’re pleased to say that 

F1 2016 delivers a full throttle experience that is just 

as interesting behind the scenes as it is on the track.

That’s mainly down to the introduction of the much-

anticipated Career Mode. It’s a vital part of virtually 

every sports sim and it’s a welcome addition to F1 

2016. Choose which driver to replace and you’ll 

automatically take his team position. Join one of the 

back markers and your goal will be to improve results, 

or join Mercedes and you’ll be under immediate 

pressure to keep the manufacturer’s winning streak 

intact. The choice is yours. You can customise your 

driver, from personal appearance to helmet design, 

and you can follow your progress from your team’s 

HQ. Your race engineer will give you targets to reach 

during every race weekend, and doing so will boost 

car engineering and performance. The level of detail 

in Career Mode is impressive if not quite at the level of 

a well-known EA Sports football game. 

On the track the level of realism has reached an 

all-time high for F1 fans. There is an initial learning 

process (we found out quickly an actual game 

controller was necessary), and there is a lot to think 

about during races, including new rules like DRS.  

F1 2016 isn’t simply a hold down the throttle and 

go kart your way around the track game – you’ll 

soon get found out if that’s your tactic. Realistic time 

penalties for such behaviour will soon catch you 

out, for example. You need to earn your position on 

the starting grid through hours of practice, but that 

makes victory when it comes all the sweeter. Lights 

out – go, go, go!“On the track the 
level of realism 
has reached an 

all-time high  
for F1 fans”

Requirements 

2.0GHzIntelProcessor•8GBRAM•1.5GBVRAM•35GBfreespace
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